Do not install this equipment in a confined space such as a bookcase or similar unit.

**WARNING**

To prevent damage which may result in fire or electric shock hazard, do not expose this appliance to rain or moisture.

**CAUTION**

Blu-ray Disc Player USES AN INVISIBLE LASER BEAM WHICH CAN CAUSE HAZARDOUS RADIATION EXPOSURE IF DIRECTED. BE SURE TO OPERATE Blu-ray Disc Player CORRECTLY AS INSTRUCTED.

**CAUTION**

THIS PRODUCT UTILIZES A LASER. USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION EXPOSURE. DO NOT OPEN COVERS AND DO NOT REPAIR YOURSELF. REFER SERVICING TO QUALIFIED PERSONNEL.

This product satisfies CE regulations when shielded cables and connectors are used to connect the unit to other equipment. To prevent electromagnetic interference with electric appliances, such as radios and televisions, use shielded cables and connectors for connections.

**IMPORTANT NOTE**

The mains lead on this equipment is supplied with a molded plug incorporating a fuse. The value of the fuse is indicated on the pin face of the plug. If it requires replacing, a fuse approved to BS1362 of the same rating must be used. Never use the plug with the fuse cover omitted if the cover is detachable. If a replacement fuse cover is required, it must be of the same colour as the pin face of the plug. Replacement covers are available from your dealer.

If the fitted plug is not suitable for the power points in your house or the cable is not long enough to reach a power point, you should obtain a suitable safety approved extension lead or consult your dealer for assistance.

However, if there is no alternative to cutting off the plug, remove the fuse and then safely dispose of the plug. Do not connect the plug to a mains jack, as there is a risk of shock hazard from the bared flexible cord.

To disconnect the apparatus from the mains, the plug must be pulled out from the mains socket, therefore the mains plug shall be readily operable. The product unit accompanying this user manual is licenced under certain intellectual property rights of certain third parties.
CLASS 1 LASER PRODUCT

This Compact Disc player is classified as a CLASS 1 LASER product. Use of controls, adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

CAUTION:

- CLASS 3B VISIBLE AND INVISIBLE LASER RADIATION WHEN OPEN. AVOID EXPOSURE TO THE BEAM. (IEC 60825-1)
- THIS product UTILIZES A LASER. USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN MAY RESULT IN HAZARDOUS RADIATION EXPOSURE. DO NOT OPEN COVER AND DO NOT REPAIR YOURSELF. REFER SERVICING TO QUALIFIED PERSONNEL.

Precautions

Important Safety Instructions

Read these operating instructions carefully before using the unit. Follow all the safety instructions listed below. Keep these operating instructions handy for future reference.

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with a dry cloth.
7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including AV receivers) that produce heat.
9. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10. Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where it exits the apparatus.
11. Only use attachments/accessories specified by the manufacturer.
12. Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.
13. Unplug this apparatus during lightning storms or when unused for long periods of time.
14. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
Safety Information

**Disc Storage & Management**

- **Holding Discs**
  - Fingerprints or scratches on a disc may reduce sound and picture quality or cause skipping.
  - Avoid touching the surface of a disc where data has been recorded.
  - Hold the disc by the edges so that fingerprints will not get on the surface.
  - Do not stick paper or tape on the disc.

- **Cleaning Discs**
  - If you get fingerprints or dirt on a disc, clean it with a mild detergent diluted in water and wipe with a soft cloth.
  - When cleaning, wipe gently from the inside to the outside of the disc.

- **Disc Storage**
  - Do not keep in direct sunlight.
  - Keep in a cool ventilated area.
  - Keep in a clean protection jacket and store vertically.

**Handling Cautions**

- Do not expose this apparatus to dripping or splashing. Do not put objects filled with liquids, such as vases on the apparatus.
- To turn this apparatus off completely, you must pull the power plug out of the wall socket. Consequently, the power plug must be easily and readily accessible at all times.
- Do not plug multiple electric devices into the same wall socket. Overloading a socket can cause it to overheat, resulting in a fire.
- Before connecting other components to this player, be sure to turn them off.
- If you move your player suddenly from a cold place to a warm place, condensation may occur on the operating parts and lens and cause abnormal disc playback. If this occurs, unplug the player, wait for two hours, and then connect the plug to the power outlet. Then, insert the disc, and try to play back again.
- If the product makes an abnormal noise or produces a burning smell or smoke, turn off the power switch immediately and disconnect the power plug from the wall outlet. Then, contact the nearest customer service centre for technical assistance. Do not use the product. Using the product as it is may cause a fire or an electric shock.

**Using the 3D function**

**IMPORTANT HEALTH AND SAFETY INFORMATION FOR 3D PICTURES.**

Read and understand the following safety information before using the 3D function.

- Some viewers may experience discomfort while viewing 3D TV such as dizziness, nausea, and headaches. If you experience any such symptom, stop viewing 3D TV, remove the 3D Active Glasses, and rest.
- Watching 3D images for an extended period of time may cause eye strain. If you feel eye strain, stop viewing 3D TV, remove your 3D Active Glasses, and rest.
- A responsible adult should frequently check on children who are using the 3D function. If there are any reports of tired eyes, headaches, dizziness, or nausea, have the child stop viewing 3D TV and rest.
- Do not use the 3D Active Glasses for other purposes (Such as general eyeglasses, sunglasses, protective goggles, etc.).
• Do not use the 3D function or 3D Active Glasses while walking or moving around. Using the 3D function or 3D Active Glasses while moving around may cause you to bump into objects, trip, and/or fall, and cause serious injury.
• If you want to enjoy 3D content, connect a 3D device (3D compliant AV receiver or TV) to the player’s HDMI OUT port using a high-speed HDMI cable. Put on 3D glasses before playing the 3D content.
• The player outputs 3D signals only through HDMI cable connected to the HDMI OUT port.
• As the video resolution in 3D play mode is fixed according to the resolution of the original 3D video, you can not change the resolution to your preference.
• Some functions such as BD Wise, screen size adjustment, and resolution adjustment may not operate properly in 3D play mode.
• You must use a high-speed HDMI cable for proper output of the 3D signal.
• Stay at least three times the width of the screen from the TV when watching 3D images. For example, if you have a 46-inch screen, stay 138 inches (11.5 feet) from the screen.
• Place the 3D video screen at eye level for the best 3D picture.
• When the player is connected to some 3D devices, the 3D effect may not function properly.
• This player does not convert 2D content into 3D.
• “Blu-ray 3D” and “Blu-ray 3D” logo are trademarks of the Blu-ray Disc Association.
# Contents

## SAFETY INFORMATION

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Warning</td>
</tr>
<tr>
<td>3</td>
<td>Precautions</td>
</tr>
<tr>
<td>3</td>
<td>Important Safety Instructions</td>
</tr>
<tr>
<td>4</td>
<td>Disc Storage &amp; Management</td>
</tr>
<tr>
<td>4</td>
<td>Handling Cautions</td>
</tr>
<tr>
<td>4</td>
<td>Using the 3D function</td>
</tr>
<tr>
<td>5</td>
<td>Copyright</td>
</tr>
</tbody>
</table>

## GETTING STARTED

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Disc and Format Compatibility</td>
</tr>
<tr>
<td>8</td>
<td>Disc types and contents your player can play</td>
</tr>
<tr>
<td>8</td>
<td>Disc types your player cannot play</td>
</tr>
<tr>
<td>9</td>
<td>Region Code</td>
</tr>
<tr>
<td>9</td>
<td>Logos of Discs the player can play</td>
</tr>
<tr>
<td>10</td>
<td>Supported Formats</td>
</tr>
<tr>
<td>13</td>
<td>Accessories</td>
</tr>
<tr>
<td>14</td>
<td>Front Panel</td>
</tr>
<tr>
<td>14</td>
<td>Rear Panel</td>
</tr>
<tr>
<td>15</td>
<td>Remote Control</td>
</tr>
<tr>
<td>15</td>
<td>Tour of the Remote Control</td>
</tr>
</tbody>
</table>

## CONNECTIONS

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Connecting to a TV</td>
</tr>
<tr>
<td>17</td>
<td>Connecting to an Audio System</td>
</tr>
<tr>
<td>17</td>
<td>Method 1 Connecting to an HDMI 4K supported AV receiver</td>
</tr>
<tr>
<td>18</td>
<td>Method 2 Connecting to an AV receiver that does not support HDMI 4K using HDMI cable</td>
</tr>
<tr>
<td>19</td>
<td>Method 3 Connecting to an Audio System (7.1 Channel Amplifier)</td>
</tr>
<tr>
<td>19</td>
<td>Method 4 Connecting to an AV receiver with Dolby Digital or DTS decoder</td>
</tr>
<tr>
<td>20</td>
<td>Connecting to a Network Router</td>
</tr>
<tr>
<td>20</td>
<td>Wired Network</td>
</tr>
<tr>
<td>20</td>
<td>Wireless Network</td>
</tr>
</tbody>
</table>

## SETTINGS

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>The Initial Settings Procedure</td>
</tr>
<tr>
<td>21</td>
<td>The Home Screen</td>
</tr>
<tr>
<td>21</td>
<td>Accessing the Settings Screen</td>
</tr>
<tr>
<td>22</td>
<td>Buttons on the Remote Control Used for the Settings Menu</td>
</tr>
<tr>
<td>23</td>
<td>Settings Menu Functions</td>
</tr>
<tr>
<td>30</td>
<td>Networks and the Internet</td>
</tr>
<tr>
<td>30</td>
<td>Configuring Your Network Connection</td>
</tr>
<tr>
<td>34</td>
<td>Wi-Fi Direct</td>
</tr>
<tr>
<td>34</td>
<td>Upgrading Software</td>
</tr>
<tr>
<td>34</td>
<td>Update Now</td>
</tr>
<tr>
<td>35</td>
<td>Auto Update</td>
</tr>
</tbody>
</table>

## MEDIA PLAY

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>36</td>
<td>The AllShare Play Screen</td>
</tr>
<tr>
<td>36</td>
<td>Accessing the AllShare Play Screen</td>
</tr>
<tr>
<td>36</td>
<td>Playing Commercial Discs</td>
</tr>
<tr>
<td>36</td>
<td>Playing Files on a USB Device</td>
</tr>
<tr>
<td>37</td>
<td>Playing a Disc with User Recorded Content</td>
</tr>
<tr>
<td>38</td>
<td>Using the Allshare Network Function</td>
</tr>
<tr>
<td>38</td>
<td>To Download the Allshare Software</td>
</tr>
<tr>
<td>39</td>
<td>Playing Content Located on Your PC or Allshare Device through the Blu-ray Disc Player</td>
</tr>
<tr>
<td>39</td>
<td>Controlling the Playback of Content Located on Your PC with Your Smart Phone</td>
</tr>
<tr>
<td>40</td>
<td>Controlling Video Playback</td>
</tr>
<tr>
<td>40</td>
<td>Buttons on the Remote Control used for Video Playback</td>
</tr>
<tr>
<td>40</td>
<td>Using the Tools Menu</td>
</tr>
<tr>
<td>42</td>
<td>Using the View &amp; Options Menus</td>
</tr>
</tbody>
</table>
CONTROLLING MUSIC PLAYBACK
Buttons on the Remote Control used for Music Playback
Using the View & Options Menus
Repeating Tracks on an Audio CD
Shuffling Tracks on an Audio CD
Creating a Playlist from an Audio CD
Ripping

PLAYING PHOTO CONTENTS
Using the Tools Menu
Using the View & Options Menus
Using the Send Function

NETWORK SERVICES
Logging In to Your Samsung Account
Before Using Movies & TV Shows or Apps
Using Movies & TV Shows
Using Apps
The Apps Screen at a Glance
Downloading Applications
Starting an Application
Using the More Apps Screen
Sorting the Apps
Using the Options Menu Functions
Screen Mirroring

USING THE WEB BROWSER
Link Browsing and Pointer Browsing
The Control Panel at a Glance
Using the Setting Menu
Linking Your Internet Service Accounts to the Player
BD-LIVE™

APPENDIX
Compliance and Compatibility Notice
Copy Protection
Network Service Disclaimer
Licence
Additional Information
Notes
Resolution according to the contents type
Digital Output Selection
Troubleshooting
Repairs
Specifications
<table>
<thead>
<tr>
<th>Media</th>
<th>Disc Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO</td>
<td>Blu-ray Disc, 3D Blu-ray Disc</td>
<td>BD-ROM or BD-RE/-R recorded in the BD-RE format.</td>
</tr>
<tr>
<td></td>
<td>DVD-VIDEO, DVD-RW, DVD-R, DVD+RW, DVD+R</td>
<td>DVD-VIDEO, recorded DVD+RW/DVD-R(W)/DVD+R/-R that have been recorded and finalized, or a USB storage media containing DivX, MKV, MP4 contents.</td>
</tr>
<tr>
<td>MUSIC</td>
<td>CD-RW/-R, DVD-RW/-R, BD-RE/-R</td>
<td>Music recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media containing MP3 or WMA contents.</td>
</tr>
</tbody>
</table>

**NOTES**
- The player may not play certain CD-RW/-R and DVD-R because of the disc type or recording conditions.
- If a DVD-RW/-R has not been recorded properly in DVD video format, it will not be playable.
- Your player will not play content that has been recorded on a DVD-R at a bit-rate that exceeds 10 Mbps.
- Your player will not play content that has been recorded on a BD-R or USB device at a bit rate that exceeds 25 Mbps.
- Playback may not work for some types of discs, or when you use specific functions, such as angle change and aspect ratio adjustment. Information about the discs is written in detail on the disc box. Please refer to this if necessary.
- When you play a BD-J title, loading may take longer than a normal title or some functions may perform slowly.

**Disc types your player cannot play**
- HD DVD
- DVD-ROM/PD/MV, etc
- DVD-RAM
- Super Audio CD (except CD layer)
- DVD-RW (VR mode)
- CVD/CD-ROM/CDV/CD-G/CD-I/LD (CD-Gs play audio only, not graphics.)
- 3.9 GB DVD-R for Authoring.
Region Code

Both players and discs are coded by region. These regional codes must match for a disc to play. If the codes do not match, the disc will not play. The Region Number for this player is displayed on the rear panel of the player.

<table>
<thead>
<tr>
<th>Disc Type</th>
<th>Region Code</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blu-ray Disc</td>
<td>A</td>
<td>North America, Central America, South America, Korea, Japan, Taiwan, Hong Kong and South East Asia.</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>Europe, Greenland, French territories, Middle East, Africa, Australia and New Zealand.</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>India, China, Russia, Central and South Asia.</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>The U.S., U.S. territories and Canada</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Europe, Japan, the Middle East, Egypt, Africa, Greenland</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Taiwan, Korea, the Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>DVD-VIDEO</td>
<td>4</td>
<td>Mexico, South America, Central America, Australia, New Zealand, Pacific Islands, Caribbean</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Russia, Eastern Europe, India, North Korea, Mongolia</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Logos of Discs the player can play

- Blu-ray Disc
- 3D Blu-ray Disc
- BD-LIVE
- DivX
- PAL

PAL broadcast System in U.K., France, Germany, etc.
## Supported Formats

### Video File Support

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Container</th>
<th>Video Codec</th>
<th>Resolution</th>
<th>Frame rate (fps)</th>
<th>Bit rate (Mbps)</th>
<th>Audio Codec</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.avi</td>
<td>AVI</td>
<td>DivX 3.11/4/5/6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mkv</td>
<td>MKV</td>
<td>MPEG4 SP/ASP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.asf</td>
<td></td>
<td></td>
<td>1920x1080 (WMV v7,v8, MSMPEG4 v3 : 1280x720)</td>
<td>6–30</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>*.wmv</td>
<td></td>
<td>H.264 BP/MP/HP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mp4</td>
<td></td>
<td>Motion JPEG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.3gp</td>
<td></td>
<td>Microsoft MPEG-4 v3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.vro</td>
<td></td>
<td>Window Media Video v7,v8,v9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mpg</td>
<td></td>
<td>MPEG2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mpeg</td>
<td></td>
<td></td>
<td>1920x1080</td>
<td>6–30</td>
<td>20</td>
<td>Vorbis</td>
</tr>
<tr>
<td>*.ts</td>
<td></td>
<td></td>
<td>640x480</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.tp</td>
<td></td>
<td></td>
<td>24/25/30</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mov</td>
<td>MOV</td>
<td>VP6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.flv</td>
<td>FLV</td>
<td></td>
<td>MVC</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.vob</td>
<td>VOB</td>
<td></td>
<td>24/25/30</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.svi</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.m2ts</td>
<td>PS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.mts</td>
<td>TS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.divx</td>
<td>SVAF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.webm</td>
<td>WebM</td>
<td>VP8</td>
<td>1920x1080</td>
<td>6–30</td>
<td>20</td>
<td>Vorbis</td>
</tr>
</tbody>
</table>

### Limitations

- Even when the file is encoded by a supported codec listed above, a file might not be played if its content is defective or corrupted.
- Normal playback is not guaranteed if the file’s container information is wrong or the file itself is corrupted.
- Files having higher bit or frame rates than indicated in the table above may stutter when played back.
- The Seek (Jump) function is not available if the file’s index table is damaged.
- When you playback a file remotely through a network connection, video playback may stutter depending on the network speed.
- Some USB/Digital camera devices may not be compatible with the product.

### Video decoder

- Supports up to H.264 Level 4.1. (Does not support FMO/ASO/RS)
- Does not support VC1/AP/L4.
- CODECs except for WMVv7, v8, MSMPEG4 v3, MVC, VP6
- Does not support GMC 2 or higher.
- Supports SVAF (Top/Bottom, Side by Side).
- Supports BD MVC Spec.

- Supports WMA 10 PRO (Up to 5.1).
- Does not support WMA lossless audio.
- Supports ADPCM IMA, MS.
- Does not support ADPCM(A-Law, μ-Law).
- Does not support QCELP/AMR NB/WB.
- Supports vorbis (Up to 2ch).
- Supports DD+ (Up to 7.1ch).

FAQ Supported DivX subtitle file formats

| NOTES |
- Playback of some DivX, MKV or MP4 file may not be supported depending on their video resolution and frame rate.

### Supported Subtitle File Formats

<table>
<thead>
<tr>
<th>Name</th>
<th>File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>External</td>
<td></td>
</tr>
<tr>
<td>SubViewer</td>
<td>.sub</td>
</tr>
<tr>
<td>Micro DVD</td>
<td>.sub or.txt</td>
</tr>
<tr>
<td>SubRip</td>
<td>.srt</td>
</tr>
<tr>
<td>SAMI</td>
<td>.smi</td>
</tr>
<tr>
<td>MPEG-4 Timed text</td>
<td>.ttxt</td>
</tr>
<tr>
<td>Advanced SubStation Alpha</td>
<td>.ssa</td>
</tr>
<tr>
<td>Powerdivx</td>
<td>.psb</td>
</tr>
<tr>
<td>Internal</td>
<td></td>
</tr>
<tr>
<td>SubRip</td>
<td>.srt</td>
</tr>
<tr>
<td>SubStation Alpha</td>
<td>.ssa</td>
</tr>
<tr>
<td>Advanced SubStation Alpha</td>
<td>.ass</td>
</tr>
<tr>
<td>Xsub</td>
<td>AVI</td>
</tr>
<tr>
<td>SubStation Alpha MKV</td>
<td>MKV</td>
</tr>
<tr>
<td>Advanced SubStation Alpha MKV</td>
<td>MKV</td>
</tr>
<tr>
<td>SubRip MKV</td>
<td>MKV</td>
</tr>
<tr>
<td>MPEG-4 Timed text MP4</td>
<td>MP4</td>
</tr>
</tbody>
</table>

### Music File Support

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Type</th>
<th>Codec</th>
<th>Support Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.mp3</td>
<td>MPEG1 Audio Layer 3</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>*.m4a</td>
<td>MPEG4 AAC</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>*.flac</td>
<td>FLAC</td>
<td>FLAC</td>
<td>Supports up to 2ch</td>
</tr>
<tr>
<td>*.ogg</td>
<td>OGG</td>
<td>Vorbis</td>
<td>Supports up to 2ch</td>
</tr>
<tr>
<td>*.wma</td>
<td>WMA</td>
<td>WMA</td>
<td>Supports WMA 10 Pro (Up to 5.1). Does not support WMA lossless audio. Supports up to M2 profile. Does not support LBR mode.</td>
</tr>
<tr>
<td>*.wav</td>
<td>wav</td>
<td>wav</td>
<td>-</td>
</tr>
<tr>
<td>*.mid</td>
<td>midi</td>
<td>midi</td>
<td>type 0 and type 1</td>
</tr>
<tr>
<td>*.ape</td>
<td>ape</td>
<td>ape</td>
<td>-</td>
</tr>
</tbody>
</table>
Getting Started

Picture File Support

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Type</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.jpg</td>
<td>JPEG</td>
<td>15360x8640</td>
</tr>
<tr>
<td>*.jpeg</td>
<td>JPEG</td>
<td>15360x8640</td>
</tr>
<tr>
<td>*.png</td>
<td>PNG</td>
<td>4096x4096</td>
</tr>
<tr>
<td>*.bmp</td>
<td>BMP</td>
<td>4096x4096</td>
</tr>
<tr>
<td>*.mpo</td>
<td>MPO</td>
<td>15360x8640</td>
</tr>
</tbody>
</table>

Notes on the USB connection

• Your player supports USB storage media, MP3 players, digital cameras, and USB card readers.
• Some USB/digital camera devices may not be compatible with the player.
• Your player supports the FAT16, FAT32, and NTFS file systems.
• Connect USB devices directly to the player’s USB port. Connecting through a USB cable may cause compatibility problems.
• Inserting more than one memory device into a multi-card reader may cause the reader to operate improperly.
• The player does not support the PTP protocol.
• Do not disconnect a USB device during a "loading" process.
• The bigger the image resolution, the longer the image takes to display.
• This player cannot play MP3 files with DRM (Digital Rights Management) downloaded from commercial sites.
• Your player only supports video that is under 30fps (frame rate).
• Your player only supports USB Mass Storage Class (MSC) devices such as thumb drives and USB HDD. (HUB is not supported.)

• Certain USB HDD Devices, multi-card readers and thumb drives may not be compatible with this player.
• If some USB devices require excessive power, they may be limited by the circuit safety device.
• If playback from a USB HDD is unstable, provide additional power by plugging the HDD into a wall socket.
• If the problem continues, contact the USB HDD manufacturer.
• SAMSUNG is not responsible for any data file damage or data loss.
• Your player does not support NTFS compressed, sparse, or encrypted files.
  - You can repair or format a USB device on your Desktop PC. (MS-Windows OS only)

AVCHD (Advanced Video Codec High Definition)

• This player can play back AVCHD format discs. These discs are normally recorded and used in camcorders.
• The AVCHD format is a high definition digital video camera format.
• The MPEG-4 AVC/H.264 format compresses images with greater efficiency than the conventional image compressing format.
• Some AVCHD discs use the "x.v.Color" format. This player can play back AVCHD discs that use "x.v.Color" format.
• "x.v.Color" is a trademark of Sony Corporation.
• "AVCHD" and the AVCHD logo are trademarks of Matsushita Electronic Industrial Co., Ltd. and Sony Corporation.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| Some AVCHD format discs may not play, depending on the recording conditions. AVCHD format discs need to be finalized.
| "x.v.Color" offers a wider colour range than normal DVD camcorder discs. |
## Accessories

Check for the supplied accessories shown below.

<table>
<thead>
<tr>
<th>Batteries for Remote Control (AAA Size)</th>
<th>User Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Setup Guide</td>
<td>Remote Control</td>
</tr>
</tbody>
</table>
Getting Started

Front Panel

PLAY/PAUSE BUTTON
STOP BUTTON
OPEN/CLOSE BUTTON

NOTES
To upgrade the player’s software through the USB Host jack, you must use a USB memory stick.
When the player displays the Blu-ray Disc menu, you cannot start the movie by pressing the Play button on the player or the remote control. To play the movie, you must select Play Movie or Start in the disc menu, and then press the button on the remote control.
To use Anynet+ (HDMI-CEC) function, connect an HDMI cable to HDMI 1 terminal. When you connect the HDMI 2 terminal, Anynet+ (HDMI-CEC) function is not available.

Rear Panel

7.1CH ANALOG AUDIO OUT
HDMI OUT
LAN
DIGITAL AUDIO OUT
Remote Control

Tour of the Remote Control

- After setup, allows you to set the input source on your TV. (This button is only available in Samsung TV.)
- Turn the player on and off. (This button is only available for Samsung TVs.)
- Press to open and close the disc tray.
- Press the number buttons to operate options.
- Use to enter the disc menu.
- Press to skip backwards or forwards.
- Press to stop a disc.
- Press to use Apps.
- Press to move to the Home screen.
- Press to use the Tools menu.
- Return to the previous menu.
- These buttons are used both for menus on the player and also several Blu-ray Disc functions.
- Press to search contents.
- Use to access various audio functions on a disc.
- Turn the TV on and off. (This button is only available for Samsung TVs.)
- TV volume adjustment. (This button is only available for Samsung TVs.)
- Use to enter the Popup menu/Title menu.
- Press to search backwards or forwards.
- Press to pause a disc.
- Press to play a disc.
- Allows you to repeat a title, chapter, track or disc.
- Use to display the playback information.
- Use to select menu items and change menu values.
- Press to exit the menu.
- Press to use full screen function. During the Blu-ray Disc/DVDs playback, this button does not operate.
- Press to switch the Blu-ray Disc/DVD’s subtitle language.

Installing batteries

If the remote control does not operate properly:
- Check the polarity +/- of the batteries.
- Check if the batteries are drained.
- Check if the remote sensor is blocked by obstacles.
- Check if there is any fluorescent lighting nearby.

CAUTION

- Dispose of batteries according to local environmental regulations. Do not put them in the household trash.
Connections

Connecting to a TV

Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI IN jack on your TV.

- Do not connect the power cord to the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use the Anynet+ (HDMI-CEC) function, connect the HDMI cable to HDMI 1 terminal. If you connect the cable to the HDMI 2 terminal, the Anynet+ (HDMI-CEC) function will not be available.</td>
</tr>
<tr>
<td>HDMI 2 terminal does not output the video signal.</td>
</tr>
<tr>
<td>If you use an HDMI-to-DVI cable to connect to your display device, you must also connect the Digital Audio Out on the player to an audio system to hear audio.</td>
</tr>
<tr>
<td>An HDMI cable outputs digital video and audio, so you don’t need to connect an audio cable.</td>
</tr>
<tr>
<td>Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.</td>
</tr>
<tr>
<td>When you connect the player to your TV using the HDMI cable or to a new TV, and then turn it on for the first time, the player automatically sets the HDMI output resolution to the highest supported by the TV.</td>
</tr>
<tr>
<td>A long HDMI cable may cause screen noise. If this occurs, set HDMI Deep Colour to Off in the menu.</td>
</tr>
<tr>
<td>To view video in the HDMI 720p, 1080i, 1080p or 2160p output mode, you must use a High speed (category 2) HDMI cable.</td>
</tr>
<tr>
<td>HDMI outputs only a pure digital signal to the TV. If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the screen.</td>
</tr>
</tbody>
</table>
Connecting to an Audio System

You can connect the Blu-ray player to the audio system using the methods illustrated below.
- Do not connect the power cord to the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

Method 1 Connecting to an HDMI 4K supported AV receiver

- Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI IN jack on your receiver.
- Best quality (Recommended)
Method 2 | Connecting to an AV receiver that does not support HDMI 4K using HDMI cable

- Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI IN jack on your receiver.
- Best quality (Recommended)

| CAUTION |
- Do not connect the HDMI OUT 1 and HDMI OUT 2 terminals of the product with an HDMI cable.
Method 3  Connecting to an Audio System (7.1 Channel Amplifier)

- Using 7.1CH audio cables (not supplied), connect the 7.1CH ANALOG AUDIO OUT terminals on the rear of the Player to the 7.1CH ANALOG AUDIO IN terminals of your Amplifier.
- Better Quality

Method 4  Connecting to an AV receiver with Dolby Digital or DTS decoder

- Using a digital Optical cable (not supplied), connect the Optical Digital Audio Out jack on the product to the Digital Optical In jack of the receiver.
- Good quality
- You will hear sound only through the front two speakers with Digital Output set to PCM.

NOTES
- The front left and right outputs on your player and 7.1 channel amplifier must be connected to hear disc menu audio from certain Blu-ray discs.
- When connecting to a 5.1 channel home theatre or receiver, connect all the Analog Audio output jacks from the player except for the Surround Back Left/Surround Back Right outputs.
Connecting to a Network Router

You can connect your player to your network router using one of the methods illustrated below. To use the AllShare network functionality, you must connect your PC to your network as shown in the illustrations. The connection can be wired or wireless.

Wired Network

| NOTES | Your router or your Internet Service Provider’s policies may prevent the player from accessing Samsung’s software update server. If this occurs, contact your Internet Service Provider (ISP) for more information.
| NOTES | DSL users, please use a router to make a network connection.

Wireless Network

| NOTES | If your wireless router supports DHCP, this player can use a DHCP or static IP address to connect to the wireless network.
| NOTES | Set your wireless router to Infrastructure mode. Ad-hoc mode is not supported.
| NOTES | The player supports only the following wireless security key protocols:
- WEP (OPEN/SHARED), WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES)
| NOTES | Select a channel on the wireless router that is not currently being used. If the channel set for the wireless router is currently being used by another device nearby, it will result in interference and communication failure.
| NOTES | If you select the Pure High-throughput (Greenfield) 802.11n mode and set the Encryption type on your router to WEP, TKIP or TKIP-AES (WPS2Mixed), the player will not support a connection in compliance with new Wi-Fi certification specifications.
| NOTES | Wireless LAN, by its nature, may cause interference, depending on the operating conditions (router performance, distance, obstacles, interference by other radio devices, etc).
The Initial Settings Procedure

- The Home screen will not appear if you do not configure the initial settings.
- The OSD (On Screen Display) may change in this player after you upgrade the software version.
- The access steps may differ depending on the menu you selected.

After you have connected the player to your TV, turn on the TV and player. When you turn on the player the first time, the player’s Initial Settings screen appears on the TV. The Initial Setting procedure lets you set the On Screen Display (OSD) and menu languages, the aspect ratio (screen size), the network type, and connect the player to your network. For complete Initial Settings instructions, see the Quick Setup Guide.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you skip Network Setup during the Initial Settings procedure, you can configure your network settings later. See “Configuring Your Network Connection” on pages 30~32 for instructions.</td>
</tr>
<tr>
<td>If you want to display the Initial Settings screen again and make changes, select Settings &gt; System &gt; Setup in the Home screen or select the Reset option. (See pages 27 or 29)</td>
</tr>
<tr>
<td>If you want to use an Anynet+(HDMI-CEC) function, please follow the instructions below.</td>
</tr>
</tbody>
</table>
  1. Connect the player to an Anynet+(HDMI-CEC)-compliant Samsung TV using HDMI Cable.
  2. Set the Anynet+(HDMI-CEC) feature to On in both the TV and the player.
  3. Set the TV to the Initial Settings Procedure. |

The Home Screen

1. **Apps** : Gives you access to various for pay or free-of-charge applications you can download.
2. **Photos, Videos & Music** : Lets you play photos, videos or music content from Disc, USB, PC or mobile devices.
3. **Settings** : Opens the player’s menu where you can set various functions to suit your personal preferences.
4. **Web Browser** : Provides access to the Internet.
5. **Recommended Apps** : Gives you direct access to recommended applications.
6. **Movies & TV Shows** : Lets you download films and TV Shows from the Internet.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depending on your country, this menu function may not be supported.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you leave the player in the stop mode for more than 5 minutes without using it, a screen saver will appear on your TV. If the player is left in the screen saver mode for more than 20 minutes, the power will automatically turn off.</td>
</tr>
</tbody>
</table>
Accessing the Settings Screen

1. Select **Settings** on the Home screen, and then press \( \text{button}.\) The Settings screen appears.

2. To access the menus, sub-menus, and options on the Settings screen, please refer to the remote control illustration below.

Buttons on the Remote Control Used for the Settings Menu

1. **HOME Button**: Press to move to the Home screen.
2. **RETURN Button**: Return to the previous menu.
3. \( \text{Button} / \text{DIRECTION Buttons} \):
   - Press \( \text{move the cursor or select an item.} \)
   - Press the \( \text{button to activate the currently selected item or confirm a setting.} \)
4. **EXIT Button**: Press to exit the current menu.

Detailed Function Information

Each Settings function, menu item, and individual option is explained in detail on-screen. To view an explanation, use the \( \) buttons to select the function, menu item, or option. The explanation will usually appear on the right side of the screen. A short description of each Settings function starts on the next page. Additional information on some of the functions is also in the Appendix of this manual.
## Settings Menu Functions

<table>
<thead>
<tr>
<th>Display</th>
<th>This option outputs HDMI video at 4K resolution. This is only available when Movie Frame is set to <strong>Auto</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4K Output</strong></td>
<td><strong>NOTES</strong></td>
</tr>
<tr>
<td></td>
<td>▶ To use this feature, you must connect the player to a device that supports 4K resolution and you must have content that plays at 24fps (frames per second).</td>
</tr>
<tr>
<td><strong>3D Settings</strong></td>
<td>Select whether to play a Blu-ray Disc with 3D contents in 3D Mode.</td>
</tr>
<tr>
<td></td>
<td>• If you move to the Home or Apps screen while in 3D mode, the player will switch to 2D automatically.</td>
</tr>
<tr>
<td><strong>TV Aspect Ratio</strong></td>
<td>Lets you adjust the output of the player to the screen size and screen format of your TV.</td>
</tr>
<tr>
<td><strong>BD Wise</strong></td>
<td>BD Wise is Samsung's latest inter-connectivity feature. When you connect a Samsung player and a Samsung TV with BD Wise to each other via HDMI, and BD Wise is on in both the player and TV, the player outputs video at the video resolution and frame rate of the Blu-ray Disc/DVD.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Set the output resolution of the HDMI video signal to BD Wise, Auto, 1080p, 1080i, 720p or 576p/480p. The number indicates the number of lines of video per frame. The i and p indicate interlaced and progressive scan, respectively. Generally, the more lines, the higher quality.</td>
</tr>
<tr>
<td><strong>Movie Frame (24Fs)</strong></td>
<td>If the player is connected to a 24Fs compatible TV, setting the Movie Frame (24Fs) feature to Auto lets the player adjust its HDMI output to 24 frames per second automatically for improved picture quality. • You can enjoy the Movie Frame (24Fs) feature only on a TV supporting this frame rate. • Movie Frame is only available when the player is in the HDMI 1080i or 1080p output resolution modes.</td>
</tr>
</tbody>
</table>
## Display

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD 24Fs Conversion</td>
<td>Converts DVD playback to 24 frames per second and outputs it via HDMI. This option is only available when Movie Frame (24Fs) is set to <strong>Auto</strong>.</td>
</tr>
<tr>
<td>Smart Hub Screen Size</td>
<td>Lets you select the optimal size for the Smart Hub Screen.</td>
</tr>
<tr>
<td>HDMI Colour Format</td>
<td>Lets you set the colour space format for the HDMI output so that it matches the capabilities of the connected device (TV, monitor, etc). The screen goes black momentarily after you have selected a format.</td>
</tr>
<tr>
<td>HDMI Deep Colour</td>
<td>Lets you set the product to output HDMI video with Deep Colour. Deep Colour provides more accurate colour reproduction with greater colour depth.</td>
</tr>
<tr>
<td>Progressive Mode</td>
<td>Lets you improve picture quality when viewing DVDs.</td>
</tr>
</tbody>
</table>

## Audio

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Output</td>
<td>Lets you select the digital audio output format that is suitable for your TV or AV Receiver. For more details, see the digital output selection table on page 67.</td>
</tr>
<tr>
<td>PCM Downsampling</td>
<td>Lets you choose to have 96Khz PCM signals downsampled to 48Khz before they are outputted to an amplifier. Choose <strong>On</strong> if your amplifier or receiver is not compatible with a 96Khz signal.</td>
</tr>
<tr>
<td>Dynamic Range Control</td>
<td>Lets you apply dynamic range control to Dolby Digital, Dolby Digital Plus, and Dolby TrueHD audio.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>Auto</strong>: Automatically controls the dynamic range of Dolby TrueHD audio, based on information in the Dolby TrueHD soundtrack. Also turns dynamic range control on for Dolby Digital and Dolby Digital Plus.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>Off</strong>: Leaves the dynamic range uncompressed, letting you hear the original sound.</td>
</tr>
<tr>
<td></td>
<td>✓ <strong>On</strong>: Turns dynamic range control on for all three Dolby formats. Quieter sounds are made louder and the volume of loud sounds is reduced.</td>
</tr>
<tr>
<td>Downmixing Mode</td>
<td>Lets you select the multi-channel downmix method that is compatible with your stereo system. You can choose to have the player downmix to normal stereo or to surround compatible stereo.</td>
</tr>
<tr>
<td>Audio</td>
<td>DTS Neo:6 Mode</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>You can enjoy multichannel sound via HDMI output from a 2 channel audio source.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Audio Sync</th>
<th>In some cases when the product is connected to a digital TV, the audio signal may not synchronize with the video signal. If this occurs, adjust the audio delay time to match the video signal.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• You can set the audio delay time between 0 msec and 200 msec. Adjust it to the optimal setting.</td>
</tr>
</tbody>
</table>

**NOTES**

- The audio delay time you specify may not be exact depending on the played content.

<table>
<thead>
<tr>
<th>HDMI Audio Output</th>
<th>Set HDMI audio to output through HDMI1 or HDMI2.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓ Auto : Audio output will be set automatically based on the devices connected to HDMI1 and HDMI2.</td>
</tr>
<tr>
<td></td>
<td>✓ HDMI1 : Audio will output to the device connected to HDMI1.</td>
</tr>
<tr>
<td></td>
<td>✓ HDMI2 : Audio will output to the device connected to HDMI2.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Speaker Settings</th>
<th>Lets you select the kind, size, and number of speakers you have attached to your player, adjust the following speaker settings for the speakers attached, and turn the test tone on and off so you can test the speakers.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓ Size : Lets you select the size of each kind of attached speaker - Large or Small - or indicate that you don’t have a particular kind of speaker attached by selecting None. If you select None for a kind of speaker, that kind of speaker will be grayed out on the Level and Distance screens.</td>
</tr>
<tr>
<td></td>
<td>✓ Level : Lets you adjust the relative loudness of each speaker from 0 dB to -6 dB.</td>
</tr>
<tr>
<td></td>
<td>✓ Distance : Lets you adjust the relative distance of each speaker from the listening position up to 30 feet. The farther the distance, the louder the speaker will be.</td>
</tr>
<tr>
<td></td>
<td>✓ Test Tone : Lets you run the Test Tone function so you can test your adjustments. Setting Test Tone to On turns the Test Tone on. Setting it to Off turns it off.</td>
</tr>
</tbody>
</table>
## Network

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network</strong></td>
<td>Lets you check the current network and Internet status.</td>
</tr>
<tr>
<td><strong>Network Status</strong></td>
<td>Configure the network connection so you can enjoy various features such as Internet services or AllShare Wi-Fi functionality, and perform Software Updates.</td>
</tr>
<tr>
<td><strong>Network Settings</strong></td>
<td>Lets you connect a Wi-Fi Direct device to the player using a peer-to-peer network, without the need for a wireless router. Note that if the player is connected to a wireless network, it may be disconnected when you use Wi-Fi Direct.</td>
</tr>
<tr>
<td><strong>Wi-Fi Direct</strong></td>
<td>Lets you connect a Wi-Fi Direct device to the player using a peer-to-peer network, without the need for a wireless router. Note that if the player is connected to a wireless network, it may be disconnected when you use Wi-Fi Direct.</td>
</tr>
<tr>
<td><strong>I NOTES I</strong></td>
<td>Text files, such as files with a .TXT or .DOC extension, will not display when you are using the Wi-Fi Direct function.</td>
</tr>
<tr>
<td><strong>AllShare Settings</strong></td>
<td>Lets you control which devices on your network, such as smart phones and tablets, can share content with your TV.</td>
</tr>
<tr>
<td><strong>Device Name</strong></td>
<td>Lets you input a name for the player that will identify it on your networks.</td>
</tr>
</tbody>
</table>
| **BD-Live Settings** | Set various BD-Live functions. BD-Live allows you to access extra features available on some Blu-ray Discs if you are connected to the Internet.  
✓ **BD-Live Internet Connection** : Lets you fully allow, partly allow, or prohibit a BD-Live Internet connection.  
✓ **BD Data Management** : Manage BD data downloaded from a BD-Live service or Blu-ray Disc. |

## Smart Features

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Apps Settings** | Lets you configure App notification settings and view basic info about your Apps.  
✓ **Push Notification Settings** : Receive notifications from selected services.  
✓ **Properties** : See basic info about Apps. |
<p>| <strong>VOD Rating Lock</strong> | You can lock access to Video on Demand (VOD) content based on its rating. |
| <strong>I NOTES I</strong>                 | Depending on your country, this menu function may not be supported. |
| <strong>Terms &amp; Conditions, Privacy Policy</strong> | You must review and agree to both the Smart Hub Terms &amp; Conditions and the privacy policy in order to enjoy Smart Hub services. |
| <strong>Reset Smart Hub</strong> | Resets the Smart Hub and Samsung account settings stored on your device. |</p>
<table>
<thead>
<tr>
<th>System</th>
<th>Setup</th>
<th>Lets you re-run the Initial Settings procedure. See the Quick Setup Guide for details.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Start</td>
<td>Lets you set the player to turn on quickly by decreasing the boot time.</td>
<td></td>
</tr>
<tr>
<td>NOTES</td>
<td>If this function is set to <strong>On</strong>, Standby power consumption will be increased.</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>You can select the language you prefer for the On-screen menu, disc menu, audio, subtitles, etc.</td>
<td></td>
</tr>
<tr>
<td>NOTES</td>
<td>The language you select for the disc menu, disc audio, or subtitles will only appear if it is supported on the disc.</td>
<td></td>
</tr>
<tr>
<td>Device Manager</td>
<td>You can connect a wireless USB keyboard or mouse to the USB port on the front of the player.</td>
<td></td>
</tr>
<tr>
<td>NOTES</td>
<td>You can use the keyboard only when a QWERTY keyboard screen or window appears in the Web Browser.</td>
<td></td>
</tr>
<tr>
<td>NOTES</td>
<td>Some USB HID keyboards and mice may not be compatible with your product.</td>
<td></td>
</tr>
<tr>
<td>NOTES</td>
<td>Some applications may not be supported.</td>
<td></td>
</tr>
<tr>
<td>NOTES</td>
<td>If a wireless HID Keyboard does not operate because of interference, move the keyboard closer to the player.</td>
<td></td>
</tr>
</tbody>
</table>
### System

<table>
<thead>
<tr>
<th>Security</th>
</tr>
</thead>
<tbody>
<tr>
<td>The default security PIN is 0000. Enter the default PIN to access the security function if you haven’t created your own PIN. After you have accessed the security function for the first time, change the PIN using the Change PIN function.</td>
</tr>
<tr>
<td>✓ <strong>BD Parental Rating</strong>: Prevents playback of Blu-ray Discs with a rating equal to or above a specific age rating you have set unless the PIN is entered.</td>
</tr>
<tr>
<td>✓ <strong>DVD Parental Rating</strong>: Prevents playback of DVDs with a rating above a specific numerical rating you have set unless the PIN is entered.</td>
</tr>
<tr>
<td>✓ <strong>Change PIN</strong>: Change the 4-digit PIN used to access security functions.</td>
</tr>
<tr>
<td>- <strong>If you forget your PIN:</strong></td>
</tr>
<tr>
<td>1. Remove any disc or USB storage device.</td>
</tr>
<tr>
<td>2. Press and hold the ■ button on the top panel for 5 seconds or more. All settings will revert to the factory default settings.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can change the options listed below to match your preferences.</td>
</tr>
<tr>
<td>✓ <strong>Front Display</strong>: Change the brightness of the front panel.</td>
</tr>
<tr>
<td>✓ <strong>Time Zone</strong>: Select the time zone in which you live.</td>
</tr>
<tr>
<td>✓ <strong>Menu Transparence</strong>: Adjust the transparency of the menu box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Anynet+ (HDMI-CEC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anynet+ is a convenient function that offers linked operations with other Samsung players that have the Anynet+ feature and lets you control those products with one Samsung TV remote. To operate this function, you must connect this player to an Anynet+ Samsung TV using an HDMI cable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DivX® Video On Demand</th>
</tr>
</thead>
<tbody>
<tr>
<td>View DivX® VOD Registration Codes to purchase and play DivX® VOD contents.</td>
</tr>
<tr>
<td><strong>Support</strong></td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td><strong>NOTES</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Software Update</strong></td>
</tr>
<tr>
<td><strong>Contact Samsung</strong></td>
</tr>
<tr>
<td><strong>Reset</strong></td>
</tr>
</tbody>
</table>
When you connect this player to a network, you can use network based applications and functions such as Smart Hub and BD-LIVE, and upgrade the player’s software through the network connection. For more information about accessing and using Internet services, see the Network Services chapter of this manual on pages 48–59. Instructions for configuring the network connection start below.

Configuring Your Network Connection

Before you begin, contact your ISP to find out if your IP address is static or dynamic. If it is dynamic, and you have a wired or wireless network, we recommend using the Automatic configuration procedures described below.

If you are connecting to a wired network, connect the player to your router using a LAN cable before you start the configuration procedure.

If you are connecting to a wireless network, disconnect any wired network connection before you begin.

To begin configuring your network connection, follow these steps:

Wired Network

1. In the Home screen, select **Settings**, and then press the ▼ button.
2. Select **Network**, and then press the ▼ button.
3. Select **Network Settings**, and then press the ▼ button.
4. Select **Wired** in the Network Settings screen, and then press the ▼ button.
5. Select **Connect** button, and then press the ▼ button. The product detects the wired connection, verifies the network connection and then connects to the network.

Wired - Manual

If you have a static IP address or the Automatic procedure does not work, you’ll need to set the Network Settings values manually.

Follow Steps 1 and 2 in Wired Network, and then follow these steps:

1. Select **Network Status**. The player searches for a network, and then displays the connection failed message.
2. On the bottom of the screen, select **IP Settings**, and then press the ▼ button. The IP Settings screen appears.
3. Select the IP Setting field, and then press the ▼ button.
4. Select **Enter manually** in the IP Setting field, and then press the ▼ button.
5. Select a value to enter (IP Address, for example), and then press the ▼ button. Use the number keypad on your remote control to enter the numbers for the value. You can also enter numbers using the ▲▼ buttons. Use the ◄► buttons on the remote control to move from entry field to entry field within a value. When done with one value, press the ▼ button.
6. Press the ▲ or ▼ button to move to another value, and then enter the numbers for that value following the instructions in Step 5.
7. Repeat Steps 5 and 6 until you have filled in all values.

| NOTES |
You can get the Network values from your Internet provider.

8. When finished entering all the values, select **OK**, and then press the ▼ button. The player verifies the network connection and then connects to the network.
Wireless Network

You can setup a wireless network connection in four ways:
- Wireless Automatic
- Wireless Manual
- WPS(PBC)
- WPS(PIN)

When you configure the wireless network connection, any wireless network devices currently connected through the player or, if applicable, the player’s current wired connection, will be disconnected.

- Wireless - Automatic

1. In the Home screen, select Settings, and then press the button.
2. Select Network, and then press the button.
3. Select Network Settings, and then press the button.
4. Select Wireless in the Network Settings screen, and then press the button. The player searches for and then displays a list of the available networks.
5. Select the desired network, and then press the button.
6. On the Security screen, enter your network’s Security Code or Pass Phrase. Enter numbers directly using the number buttons on your remote control. Enter letters by selecting a letter with an arrow button, and then pressing button.

| NOTES |

- To view the password as you enter it, use the arrow buttons to select Show Password on the right side, and then press button.
7. When done, select Done and then press the button.
8. When verification is complete, select OK, and then press the button.

| NOTES |

- You should be able to find the Security Code or Pass Phrase on one of the setup screens you used to set up your router or modem.

- Wireless - Manual

If you have a static IP address or the Automatic procedure does not work, you’ll need to set the Network Settings values manually.

1. Follow the directions in Wireless - Automatic through Step 5.
2. The player searches for a network, and then displays the connection failed message.
3. On the bottom of the screen, select IP Settings, and then press the button. The IP Settings screen appears.
4. Select the IP Setting field, and then press the button.
5. Select Enter manually in the IP Setting field, and then press the button.
6. Select a value to enter (IP Address, for example), and then press \( \text{button}. Use the number keypad on your remote control to enter the numbers for the value. You can also enter numbers using the ▲▼ buttons. Use the ◄► buttons on the remote control to move from entry field to entry field within a value. When done with one value, press the \( \text{button}.

7. Press the ▲ or ▼ button to move to another value, and then enter the numbers for that value following the instructions in Step 6.

8. Repeat Steps 6 and 7 until you have filled in all values.

| NOTES |
- You can get the Network values from your Internet provider.

9. When finished, select OK, and then press the \( \text{button}.

10. On the Security screen, enter your network’s Security Code or Pass Phrase. Enter numbers directly using the number buttons on your remote control. Enter letters by selecting a letter with the ▲▼◄► buttons, and then pressing the \( \text{button}.

11. When finished, select Done at the right of the screen, and then press the \( \text{button}.

The player verifies the network connection and then connects to the network.

12. After the player verifies the network, select OK, and then press the \( \text{button}.

### WPS(PBC)

1. In the Home screen, select Settings, and then press the \( \text{button}.

2. Select Network, and then press the \( \text{button}.

3. Select Network Settings, and then press the \( \text{button}.

4. Select Wireless in the Network Settings screen, and then press the \( \text{button}.

5. Press the ▲ button on your remote, and then press the ► button to select the WPS(PBC).

6. Press the \( \text{button} on your remote. The "Press the PBC button" message appears.

7. Press the WPS(PBC) button on your router within two minutes. Your player automatically acquires all the network settings values it needs and connects to your network. The Network Status screen appears. The player connects to the network after the network connection is verified.

### WPS(PIN)

Before you begin, open the router’s setup menu on your PC and access the screen with the WPS PIN entry field.

1. In the Home screen, select Settings, and then press the \( \text{button}.

2. Select Network, and then press the \( \text{button}.

3. Select Network Settings, and then press the \( \text{button}.

4. Select Wireless in the Network Settings screen, and then press the \( \text{button}.

5. Select the desired network, and then press the ► button.

6. Select the WPS(PIN), and then press the \( \text{button}.

7. Enter the PIN into the WPS PIN entry field in the router’s Set Up screen and then save the screen.

| NOTES |
- Contact the manufacturer of the router for instructions explaining how to access the route’s Set Up screens or refer to the router’s user’s manual.
- For WPS connection, set your wireless router’s security encryption to AES. Setting to WEP security encryption does not support WPS connection.
Wi-Fi Direct

The Wi-Fi Direct function allows you to connect Wi-Fi Direct devices to the player and each other using a peer-to-peer network, without a wireless router.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Some Wi-Fi Direct devices may not support the AllShare function if connected via Wi-Fi Direct. If this is the case, it is advisable to change the network connection method between devices.</td>
</tr>
<tr>
<td>• Bluetooth transmissions can interfere with the Wi-Fi Direct signal. Before you use the Wi-Fi Direct function, we strongly recommend that you turn off the Bluetooth function of any active mobile device.</td>
</tr>
</tbody>
</table>

1. Turn on the Wi-Fi direct device and activate its Wi-Fi Direct function.
2. In the Home screen, select Settings, and then press the button.
3. Select Network, and then press the button.
4. Select Wi-Fi Direct, and then press the button.
   The Wi-Fi Direct devices that you can connect appear.
5. You have three ways to complete the Wi-Fi connection:
   • Through the Wi-Fi device.
   • Through the player using PBC.
   • Through the player using a PIN.
   Each is covered below.

Through the Wi-Fi Device

1. On the Wi-Fi device, follow the procedure on the device for connecting to another Wi-Fi Direct device. See the device’s user manual for instructions.
2. When you have completed the procedure, you should see a pop-up on your TV screen saying that a device that supports Wi-Fi Direct has requested to connect. Select OK, and then press the button to accept.
3. The Connecting pop-up appears, followed by the Connected pop-up. When it closes, you should see the device listed on the Wi-Fi Direct screen as connected.

Through the Player Using PBC

1. Select the Wi-Fi Direct device you want to connect to this player, and then press the button. The PBC/PIN pop up appears.
2. Select PBC, and then press the button. The PBC pop-up appears.
3. Press the PBC button on the Wi-Fi Direct device within 2 minutes.
4. The Connecting pop-up appears, followed by the Connected pop-up. When it closes, you should see the device listed on the Wi-Fi Direct screen as connected.

Through the Player Using a PIN

1. Select the Wi-Fi Direct device you want to connect to this player, and then press the button. The PBC/PIN pop up appears.
2. Select PIN, and then press the button. The PIN pop-up appears.
3. Note the PIN code in the pop-up, and then enter it into the appropriate field in the Wi-Fi Direct device you want to connect.
4. The Connecting pop-up appears, followed by the Connected pop-up. When it closes, you should see the device listed on the Wi-Fi Direct screen as connected.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The current wired or wireless network connection will be disconnected when you use the Wi-Fi Direct function.</td>
</tr>
<tr>
<td>• Text files, such as files with a .TXT or .DOC extension, will not display when you are using the Wi-Fi Direct function.</td>
</tr>
</tbody>
</table>
The Software Update menu allows you to upgrade the player’s software for performance improvements or additional services.

- Never turn the player off or back on manually during the update process.

1. In the Home screen, select the **Settings**, and then press the **v** button.
2. Select **Support**, and then press the **v** button.
3. Select **Software Update**, and then press the **v** button.
4. To download update software and update now, select **Update Now**, and then press the **v** button. See Update Now on this page for details.
5. To let the product download update software automatically when available, select **Auto Update**, and then press the **v** button. See Auto Update on page 35 for details.

**NOTES**
- The upgrade is complete when the player turns off, and then turns on again by itself.
- Samsung Electronics shall takes no legal responsibility for player malfunction caused by an unstable Internet connection or consumer negligence during a software Update.
- If you want to cancel the upgrade while the upgrade software is downloading, press the **c** button.
- When a system upgrade is in progress, "UPDATE" is displayed on the front panel.

**Update Now**

You can use Update Now to update the software through your network connection or by using a USB flash drive. The network instructions are below. The USB flash drive instructions are on the next page.

1. Select **Update Now**, and then press the **v** button. The Update now pop-up appears.
2. The product searches on line for the latest software version.
3. If it finds a new version, the Update Request pop-up appears.
4. Select **OK**. The product upgrades the software, turns off, and then turns on automatically.
5. If you do not select **OK** or **Cancel** in one minute, the product stores the new upgrade software. You can upgrade the software later using **Auto Update**.
6. If you select **Cancel**, the product cancels the upgrade.

**NOTES**
- When the system upgrade is done, check the software details in the Product Information section of the Contact Samsung screen.
- Do not turn off the player during the Software Update. It may cause the player to malfunction.
Auto Update

You can set the Auto Update function so that the player downloads new upgrade software when it is in Auto Update mode.
In Auto Update mode, the player is off, but its Internet connection is active. This allows the player to download upgrade software automatically, when you are not using it.

1. Press the ▲▼ buttons to select Auto Update, and then press the ◄ button.
2. Select On or Off.
If you select On, the player will automatically download new upgrade software when it is in Auto Update mode with the power off. If it downloads new upgrade software, the player will ask you if you want to install it when you turn the player on.

| NOTES |
| To use the Auto Update Mode Upgrade function, your player must be connected to the Internet.

< By USB >

2. Click SUPPORT on the top right of the page.
3. Enter the product’s model number into the search field. As you enter the model number, a drop down will display products that match the model number.
4. Left click your product’s model number in the drop down list.
5. On the page that appears, scroll down to and then click Firmware Manuals & Downloads.
6. Click Firmware in the centre of the page.
7. Click the ZIP button in the File column on the right side of the page.
8. Click Send in the first pop-up that appears. Click OK in the second pop-up to download and save the firmware file to your PC.

9. Unzip the zip archive to your computer. You should have a single folder with the same name as the zip file.
10. Copy the folder to a USB flash drive.
11. Make sure no disc is inserted in the product, and then insert the USB flash drive into the USB port of the product.
12. In the product’s menu, go to Settings > Support > Software Update.
13. Select Update Now.
14. The product searches for the software on the USB drive. When it finds the software, the Update Request pop-up appears.
15. Select OK. The product upgrades the software, turns off, and then turns on automatically.

| NOTES |
| There should be no disc in the player when you upgrade the software using the USB jack.
| When the system upgrade is done, check the software details in the Product Information section of the Contact Samsung screen.
| Do not turn off the player during the Software Update. It may cause the player to malfunction.
| Software Updates using the USB jack must be performed with a USB flash memory stick only.
Media Play

Your Blu-ray Disc Player can play content located on Blu-ray/DVD/CD discs, USB devices, PCs, smart phones, tablets, and on the Web. To play content located on your PC or on mobile devices, you must connect them to this product to your network. To play content on your PC, you must also install Allshare network software on your PC.

| NOTES |
- PCs running Windows 7 and Windows 8 have Allshare software (Play To) built in.

The AllShare Play Screen

For all media, the AllShare Play Main screen or one of its sub screens is your primary means of accessing and playing contents saved on a variety of devices, either connected directly or using your network.

Accessing the AllShare Play Screen

To access the AllShare Play Main screen, select Photos, Videos & Music on the Home screen, and then press the ▼ button.

Playing Commercial Discs

1. Press the ▲ button to open the disc tray.
2. Place a disc gently into the disc tray with the disc's label facing up.
3. Press the ▼ button to close the disc tray. Playback starts automatically.
4. If playback does not start automatically, press the ▶ button on the remote control.

Playing Files on a USB Device

There are two methods you can use to play or view multimedia files located on a USB device through your player.

Method 1

1. Turn the player on.
2. Connect the USB device to the USB port on the front panel of the player. The New Device Connected pop-up appears.
3. If the pop-up does not appear, go to Method 2.
4. Use the ▲▼ buttons to select Photos, Videos, Music or All Content, and then press the ▼ button. The AllShare Play screen appears listing the content of the device. Depending on how the contents is arranged, you will see either folders, individual files, or both.
I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the All Share Play screen and going to Step 4 in Method 2 below.

4. If necessary, use the the ▲▼◄► buttons to select a folder, and then press the button.

5. Select a file to view or play, and then press the button.

6. Press the RETURN button to exit a folder or the EXIT button to return to the Home screen.

7. Go to pages 40~47 for instructions that explain how to control playback of videos, music, and pictures on a USB device.

I NOTES I

- If you insert a disc when playing a USB device, the device mode changes to "Disc" automatically.

Method 2

1. Turn the player on.
2. Connect the USB device to the USB port on the front panel of the player.
3. Select Photos, Videos & Music on the Home screen, and then press the button.
4. Select Photos, Videos, Music or All Content, and then press the button.

I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the AllShare Play screen and repeating Step 4.

5. Use the ▲▼◄► buttons to select the desired device and then press the button. Depending on how the contents are arranged, you will see either folders, individual files, or both.

6. If necessary, use the ▲▼◄► buttons to select a folder, and then press the button.

7. Use the ▲▼◄► buttons to select a file to view or play, and then press the button.

8. Press the RETURN button to exit a folder or the EXIT button to return to Home screen.

9. Go to pages 40~47 for instructions that explain how to control playback of videos, music, and pictures on a USB device.

I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the AllShare Play screen and repeating Step 2.

3. A screen appears listing the contents of the disc. Depending on how the contents are arranged, you will see either folders, individual files, or both.

| NOTES |

Playing a Disc with User Recorded Content

You can play multimedia files you have recorded on Blu-ray, DVD, or CD discs.

1. Place a user recorded disc into the disc tray with the disc's label facing up, and then close the tray. The Device Connected pop-up appears.

2. Use the ▲▼ buttons to select the type of content you want to view or play - Photos, Videos, Music, or All Content - and then press the button.

I NOTES I

- Even though the player will display folders for all content types, it will only display files of the Content Type you selected in Step 2. For example, if you selected music, you will only be able to see music files. You can change this selection by returning to the AllShare Play screen and repeating Step 2.

3. A screen appears listing the contents of the disc. Depending on how the contents are arranged, you will see either folders, individual files, or both.
4. If necessary, use the ▲▼◄► buttons to select a folder, and then press the ▼ button.

5. Use the ▲▼◄► buttons to select a file to view or play, and then press the ▼ button.

6. Press the RETURN button one or more times to exit a current screen, exit a folder, or to return to the Home screen. Press the EXIT button to return directly to the Home Screen.

7. Go to pages 40–47 for instructions that explain how to control playback of videos, music, and pictures on a disc.

Using the Allshare Network Function

Allshare software lets you play Photos, Videos, or Music located on your PC or your Allshare compatible device through the player using a wireless connection.

To Download the Allshare Software

If your PC is not running Windows 7 or 8, you must install Allshare software on your PC to use the Allshare function. You can download the Allshare software and get detailed instructions for using the Allshare software from the Samsung.com website.

2. Click Support at the top of the page.
3. On the Support page, enter the model number of your player into the Model Number field, and then press the ▼ button.
4. On the page that appears, click See All Downloads on the left side of the screen under Downloads. The Download Tab appears.

5. On the Download Tab, click Software.
6. In the list of software, click the EXE button on the right side of the Allshare software line.
7. In the pop-up that appears, click the Send button.
8. In the next pop-up, click Save File.
9. Find the Allshare install file on your disk, and then double click the file.
10. In the pop-up that appears, click Run, and then follow the directions that appear on your screen.

Download the Allshare software Installation/Instruction manual from the same Software Tab by clicking the corresponding PDF file symbol in the File column on the right. The file, in PDF format, will download and open. You can view and/or save the file.
**Playing Content Located on Your PC or Allshare Device through the Blu-ray Disc Player**

1. Connect the Blu-ray Disc Player, your PC, and/or your Allshare compatible device to the same wireless network.

2. Follow the directions in the Allshare software Installation/Instruction manual to set up devices and files for playing or viewing.

3. Select **Photos, Videos & Music** on the player’s Home screen, and then press the \( \text{v} \) button. The AllShare Play screen appears.

4. Select the type of content you want to play - Photos, Videos, Music, or All Content - and then press the \( \text{v} \) button.

5. On the next screen, select Allshare, and then press the \( \text{v} \) button.

6. In the list of Allshare connected devices that appears, select your PC or other Allshare compatible device, and then press the \( \text{v} \) button. A screen listing the available files appears.

7. Select the file you want to play or view, and then press the \( \text{v} \) button.

**Controlling the Playback of Content Located on Your PC with Your Smart Phone**

(Only available with Samsung phones supporting Allshare functionality.)

1. Connect the Blu-ray Disc Player, your PC, and your Allshare compatible cellular phone to the same wireless network.

2. Follow the directions in the Allshare software Installation/Instruction manual to set up devices and files for playing or viewing.

3. On your computer, using the Allshare software, confirm your phone is connected.

4. On the phone, select the file you want to view or play, and then select the Blu-ray player as the playback device.

5. On the phone, start playback.
Controlling Video Playback

You can control the playback of video content located on a Blu-ray/DVD disc, USB, mobile device or PC. Depending on the disc or contents, some of the functions described in this manual may not be available.

Buttons on the Remote Control used for Video Playback

<table>
<thead>
<tr>
<th>Using the disc menu, title menu, popup menu, and title list</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DISC MENU</strong> button</td>
</tr>
<tr>
<td><strong>TITLE MENU</strong> button</td>
</tr>
<tr>
<td><strong>VIEW</strong> button</td>
</tr>
<tr>
<td><strong>POPUP MENU</strong> button</td>
</tr>
</tbody>
</table>

Using the Tools Menu

During playback or in pause mode, press the **TOOLS** button.

Play from the Beginning

Select to return to the beginning of the movie, and then press the **play** button.

3D

Use 3D menu to select Side by Side or Top and Bottom option if the 3D content currently playing does not properly appear in 3D mode.

I NOTES I

» Use 3D menu for 3D contents only. If applied to 2D contents, it may not be displayed properly.

Movie Note

Movie Note provides information such as director, cast, synopsis, etc.

I NOTES I

» This function is available if the disc includes Movie Note information and the player is connected to a network.

Search Scene

You can use the Search Scene function during playback to view or start a movie from the scene of your choice.
### Search Scene

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the index information in the file is damaged or the file does not support indexing, you will not be able to use the Search Scene function.</td>
</tr>
<tr>
<td>If you are using the Allshare function after connecting to a computer through your network, Search Scene may not be supported.</td>
</tr>
</tbody>
</table>

### Search Titles

If there is more than one movie on the disc or device, select to start a different title.

1. Select Search Titles, and then press the ▼ button.
2. Use the ▲▼ buttons to select a title, and then press the ▼ button.

### Search Chapters

Select to play the chapter of your choice.

1. Select Search Chapters, and then press the ▼ button.
2. Use the ▲▼ buttons to select a chapter, and then press the ▼ button.

### Search Time Bar

Select to play the movie from a selected time point.

1. Select Search Time Bar, and then press the ▼ button.
2. Using the number buttons, enter the time point you want to go to, and then press the ▼ button.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can also use the ◀▶ buttons to advance or rewind the movie. The movie advances or rewinds one minute each time you press the ◀▶ buttons.</td>
</tr>
</tbody>
</table>

### Repeat Mode

Select to repeat a title, chapter, or specific section.

- Off: Select to return to normal playback.
- Title: Choose to repeat a selected title.
- Chapter: Choose to repeat a specific chapter.
- Repeat A-B: Choose to repeat a specific section.

1. Press the ▲▼ buttons to select repeat A-B, and then press the ▼ button.
2. Press the ▼ button at the point where you want repeat play to start (A). Let the movie play.
3. Press the ▼ button at the point where you want repeat play to stop (B).

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must set point (B) at least 5 seconds of playing time after point (A).</td>
</tr>
</tbody>
</table>

### Picture Mode

Select to set the picture mode.

- Dynamic: Increases sharpness and brightness.
- Standard: Choose this setting for most viewing applications.
- Movie: The best setting for watching movies.
- User: Lets you adjust the sharpness and noise reduction function respectively.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you use the BD wise function, this menu will not appear.</td>
</tr>
</tbody>
</table>

### Audio

Select to set the desired audio language.
Media Play

**Subtitle**
Select to set the desired subtitle language.
- You can also operate this function by pressing the SUBTITLE button on the remote control.

**Subtitle Settings**
Select to set the desired subtitle options.

**Angle**
Select to view a scene from another angle. The Angle option displays the number of angles available to view. When a Blu-ray Disc/DVD contains multiple angles of a particular scene, you can change angle.

**BONUSVIEW Video**
Select to set the desired bonusview option.

**BONUSVIEW Audio**

**Full screen**
Select to set the size of the video image. Choose Original, Mode 1 (larger), or Mode 2 (largest).

**Information**
Select to view video file information.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depending on the disc or storage device, the Tools menu may differ or not be shown.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video files with high bit rates of 20Mbps or more strain the player’s capabilities and may stop playing during playback.</td>
</tr>
</tbody>
</table>

**Using the View & Options Menus**

**Using the View Menu**
On the video file playback screen, use the ▲▼◄► buttons to select **View** and then press the ▼ button.

<table>
<thead>
<tr>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays all the video files on the media or storage device by title.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays all the folders with videos by date. If you select a folder, and then press the ▼ button, displays all the videos in the folder by date.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays all the folders on the media or storage device.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Playlist</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays available play lists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Title List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays all the video files on the media or storage device by title. Alternate to Title.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depending on the disc or storage device, the View menu may differ or not be shown.</td>
</tr>
</tbody>
</table>

**Using the Options Menu**
On the video file playback screen, use the ▲▼◄► buttons to select **Options** and then press the ▼ button.

<table>
<thead>
<tr>
<th>Play Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lets you create a playlist by selecting specific files to play. It works essentially the same way for all media. See Creating a Playlist on an Audio CD on pages 44–45.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Send</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select to upload selected files to on-line sites (Picasa, Facebook etc) or a device. To use this function, you need to establish an account with the on-line site, and then log in using the Log In function.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select to delete a file from a device.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depending on the disc or storage device, the Options menu may differ or not be shown.</td>
</tr>
</tbody>
</table>
**Controlling Music Playback**

You can control the playback of music content located on a DVD, CD, USB, mobile device or PC. Depending on the disc or contents, some of the functions described in this manual may not be available.

**Buttons on the Remote Control used for Music Playback**

1. NUMBER buttons: If numbered tracks are displayed, press the number of a track. The selected track is played.
2. button: Moves to the previous/next track.
3. button: Stops a track.
4. Fast Play (Audio CD (CD-DA) only)
   During playback, press the or button. Each time you press the or button, the playback speed will change.
5. button: Pauses a track.
6. button: Plays the currently selected track.

**Using the View & Options Menus**

**Using the View Menu**

On the music file playback screen, use the buttons to select View, and then press the button.

<table>
<thead>
<tr>
<th>Track</th>
<th>Displays all the music tracks on the media or storage device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Album</td>
<td>Displays all music on the media or storage device by album.</td>
</tr>
<tr>
<td>Artist</td>
<td>Displays all the music files on the media or storage device by artist.</td>
</tr>
<tr>
<td>Genre</td>
<td>Displays all the music on the media or storage device by genre.</td>
</tr>
<tr>
<td>Folder</td>
<td>Displays all the folders on the media or storage device.</td>
</tr>
</tbody>
</table>

**NOTES**

- Depending on the disc or storage device, the View menu may differ or not be shown.

**Using the Options Menu**

On the music file playback screen, use the buttons to select Options and press the button.

<table>
<thead>
<tr>
<th>Play Selected</th>
<th>Lets you create a playlist by selecting specific files to play. It works essentially the same way for all media. See Creating a Playlist on an Audio CD on pages 44–45.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send</td>
<td>Select to send selected files to other devices.</td>
</tr>
</tbody>
</table>
Ripping
The Ripping function converts CD audio to the mp3 format and saves the converted files on a USB device or the mobile device connected to the player. See Ripping on page 45.

Information
Select to see the (Contents) information.

Encoding
Select to manage the text encoding options.

Delete
Select to delete a file from the device.

### Ripping

The Ripping function converts CD audio to the mp3 format and saves the converted files on a USB device or the mobile device connected to the player. See Ripping on page 45.

### Information

Select to see the (Contents) information.

### Encoding

Select to manage the text encoding options.

### Delete

Select to delete a file from the device.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>❸ Depending on the disc or storage device, the Options menu may differ or not be shown.</td>
</tr>
</tbody>
</table>

## Repeating Tracks on an Audio CD

You can set the product to repeat tracks on an audio CD (CD-DA/MP3).

### Step 1

On the Playback screen, use the ▲▼◄► buttons to select the repeat option in the lower left corner of the screen, and then press the ▼ button.

### Step 2

Use the ▲▼ to select the repeat mode you want - Off, One Song, or All - and then press the ▼ button.

## Shuffling Tracks on an Audio CD

You can set the product to play tracks on an audio CD (CD-DA/MP3) at random.

### Step 1

On the Playback screen, use the ▲▼◄► buttons to select the shuffle option in the lower left corner of the screen, and then press the ▼ button.

### Step 2

Use the ▲▼ to set the Shuffle mode On or Off, and then press the ▼ button.

## Creating a Playlist from an Audio CD

You can create a playlist with up to 99 tracks on Audio CDs (CD-DA).

### Step 1

With the Playback screen displayed, select the Options button, and then press the ▼ button. The Options menu appears.

### Step 2

Use the ▲▼ buttons to select the Shuffle mode On or Off, and then press the ▼ button. The Selection Play screen appears.

### Step 3

Use the ▲▼ buttons to select a track, and then press the ▼ button. A check appears to the left of the track.

### Step 4

Repeat Step 3 to select and check additional tracks.

### Step 5

To remove a track from the list, move to the track, and then press the ▼ button again. The check on the track is removed.

### Step 6

When done, press the ▲▼ button to select Play, and then press the ▼ button. The Music Playback screen reappears listing only the tracks you checked. The selected tracks play automatically.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
</table>
| ❸ You can create a playlist with up to 99 tracks on Audio CDs (CD-DA).
| ❸ If you have created a playlist, Play Selected is replaced by Edit Playlist on the Options menu.
| ❸ On the Selection Play screen, you can also choose Select All, Clear All, and Cancel. |
- Use Select All to select all tracks. This cancels your individual track selections. When you press the RETURN button on your remote control or select the Play button, and then press the button, all tracks will appear on the Music Playback screen, and the product will begin to play all tracks from Track 001.

- Use Clear All to deselect all selected tracks at once. Then, select individual tracks or use Select All to select all the tracks, and then press the RETURN button on your remote control. If you do not use Select All or select individual tracks, the Playlist will not change.

- Cancel cancels any changes you made on the Play Select screen. When you return to the Playback screen, the Playlist will be unchanged.

### Ripping

1. Insert a USB device into the USB jack on the front of the product.
2. With the Playback screen displayed, select the Options and then press the button. The Options menu appears.
3. Use the ▲▼ buttons to select Ripping, and then press the button. The Ripping screen appears.
4. Use the ▲▼ buttons to select a track, and then press the button. A check appears to the left of the track.
5. Repeat Step 4 to select and check additional tracks.
6. To remove a track from the list, move to the track, and then press the button. The check on the track is removed.
7. When done, select the Rip button using the ▲▼ buttons, and then press the button. The Rip pop-up appears.
8. Use the ▲▼ buttons to select the device to store the ripped files to, and then press the button.

### I NOTES

- Do not disconnect the device while ripping is in progress.

9. If you want to cancel ripping, press the button and then select Yes. Select No to continue ripping.

10. When ripping is complete, the "Successfully Ripped." message appears. Press the button.

11. Press the RETURN button or select Cancel, and then press the button to go back to the Playback screen.

### I NOTES

- This function is not available with DTS Audio CD.
- This function may not be supported by some discs.
- Ripping encodes music to the .mp3 format at 192kbps.
- On the Ripping screen, you can also choose Select All and Clear All.
  - Use Select All to select all tracks and press the button. This cancels your individual track selections.
  - Use Clear All to deselect all selected tracks at once.

### Playing Photo Contents

You can play photo contents located on a DVD, USB, mobile device or PC.

#### Using the Tools Menu

During playback, press the TOOLS button. A series of icons appears at the bottom of the screen. The icons, which are shown from left to right on the screen, are shown in the same order, from top to bottom, in the table below.

<table>
<thead>
<tr>
<th>Previous</th>
<th>Select to move to the previous picture.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Select to move to the next picture.</td>
</tr>
<tr>
<td>Start / Stop Slide Show</td>
<td>Select to play/pause the slide show.</td>
</tr>
</tbody>
</table>
Media Play

Slide Show
Settings
Select the Slide Show settings.

Zoom
Select to enlarge the current picture. (Enlarge up to 4 times)

Rotate
Select to rotate the picture. (This will rotate the picture either clockwise or counter clockwise.)

Background Music
Select to listen to music while viewing a slide show.

Settings
Select the picture mode - Dynamic, Standard, Movie, or User - or display information about the current picture.

| NOTES |
Depending on the disc or storage device, the Tools menu may differ or not be shown.

To enable the background music function, the photo file must be in the same storage media as the music file. However, the sound quality can be affected by the bit rate of the MP3 file, the size of the photo, and the encoding method.

You can’t enlarge the subtitle and PG graphic in the full screen mode.

Using the Options Menu

On a file screen containing photo files, select the Options and press the button.

| Slide show |
Starts the slide show. Shows all the files in the current folder, one after another. If you want to create a slide show with a selected group of photos, see Play Selected below.

| Play Selected |
Lets you create a playlist by selecting specific photos to see. It works essentially the same for all media. See Creating a Playlist from an Audio CD on pages 44-45 for instructions.

| Send |
Select to upload selected files to an on-line site (Picasa, Facebook etc) or a device. To use this function, you need to establish an account with the on-line site, and then log in using the Log In function. See Using the Send Function on page 47.

| Delete |
Select to delete the a file from the device.

| NOTES |
Depending on the disc or storage device, the Options menu may differ or not be shown.

Using the View & Options Menus

Using the View Menu

On a file screen containing photo files, select the View and press the button.

| Title |
Displays all the photo files on the media or storage device by title.

| Date |
Groups all the the photo files on the media or storage device by date. Click a group to see the photos in that group.

| Folder |
Displays all the folders on the media or storage device.

| NOTES |
Depending on the disc or storage device, the View menu may differ or not be shown.
Using the Send Function

You can upload files to an on-line site (Picasa, Facebook etc) or a device.

1. With the Photo Playback screen displayed, select the Options button, and then press the ▼ button. The Options menu appears.
2. Use the ▲▼ buttons to select Send, and then press the ▼ button. The Selection screen appears.
3. Use the ▲▼ buttons to select a picture, and then press the ▼ button. A check appears to the left of the picture.
4. Repeat Step 3 to select and check additional pictures.
5. To remove a picture from the list, move to the picture, and then press the ▼ button again. The check on the picture is removed.
6. When done, press the ▲▼ button to select Send, and then press the ▼ button. The Send pop-up appears listing the on-line sites (Picassa, Facebook, etc.) or devices that you can send the photos to.
7. Select a destination, and then press the ▼ button.
8. If you are sending the photos to an on-line site, the site starts. Log in and follow the directions on the screen.

NOTES

To send photos to an on-line site you must have an account with that site.
Network Services

You can enjoy various network services such as streaming video or on-line apps by connecting the player to your network.

To use network services, you must first:
1. Connect the player to the network. (See page 30)
2. Configure the network settings. (See pages 30–33)

Logging In to Your Samsung Account

Before you access Movies & TV Shows or Apps, we suggest you log in to your Samsung account.

I NOTES I
- If you do not have a Samsung account, follow the directions in the Quick Startup Guide to create one.

To log in to your Samsung account, follow these steps:
1. With the Home screen displayed, press the RED (A) button. The Log In screen appears.
2. Select the Email field, and then press the button. The keyboard pop-up appears.
3. Using the keyboard, enter your e-mail address. When finished, select the Done button, and then press the button. The Log In screen re-appears.
4. Select the Password field, and then press the button. The keyboard pop-up appears.
5. Using the keyboard, enter your password. When finished, select the Done button, and then press the button. The Log In screen re-appears.
6. To make the log in process easier next time, select Sign me in automatically, and then press the button.
7. Select Log In, and then press the button. The player logs you in to your account. Your account e-mail is displayed on the bottom left of the screen.

I NOTES I
- If you selected Sign me in automatically, the next time you log in, the player will automatically enter your e-mail and password. All you need to do is select Log In.
- If your e-mail address and password are not displayed when the Log In screen appears, select the button with the down pointing arrow head next to the Email field, and then press the button. A drop down list of all your registered accounts will appear. Select your account, and then press the button. The player will fill in the e-mail and password fields.
- If you press the RED (A) button after you have logged in, the My Account pop-up appears. On the pop-up, you can select Logout, Change account information, Link Service Accounts, Remove Accounts from the Device, and Deactivate Account.
- To rent Films and purchase for-pay apps, you must have a credit card registered in your account. If you haven’t registered a card, select Change account information. On the Change Account information page, select Register Card, press the button, and then follow the directions on the screen.

Before Using Movies & TV Shows or Apps

If you haven’t set up Smart Hub, when you use Movies & TV Shows or Apps for the first time, the player will ask you to perform the Smart Hub set up procedure.
1. On the Home screen, select either **Movies & TV Shows** or **Apps**, and then press the **OK** button. If you have selected **Apps**, go to Step 4.

2. If you selected **Movies & TV Shows**, the Smart Hub pop-up appears asking if you want to set up Smart Hub. Select **Yes**, and then press the **OK** button. The Welcome screen appears.

3. Select **Start**, and then press the **OK** button. The Smart Hub Terms & Conditions, Privacy Policy screen appears.

4. On the Smart Hub Terms & Conditions, Privacy Policy screen, you must review and agree to both the Smart Hub Terms and Conditions and the Privacy Policy to use Smart Hub.

5. Scroll down, and then click the **View details** buttons to review the full documents.

6. When done reading, scroll up to the first entry field, and press the **OK** button to agree to the Terms and Conditions and consent to the Privacy Policy.

7. Press the ► button twice to go to the Supplemental Privacy Notices screen.

8. Click the **View details** button to view the entire notice.

9. When done reading, scroll up to the top entry field, and then press the **OK** button.

<table>
<thead>
<tr>
<th>NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>You do not need to consent to the Supplemental Privacy Notice, but one or more Smart TV features or functionalities may not be available if you do not.</td>
</tr>
</tbody>
</table>

10. Press the ► button twice. The Setup Complete screen appears. Press the **OK** button.

---

**Using Movies & TV Shows**

You can download or stream for pay and free-of-charge Films and TV shows and view them on your TV.

1. On the Home screen, select **Movies & TV Shows**, and then press the **OK** button.

2. Select one of the Featured or Recommended Films, and then press the **OK** button. The page for that movie appears.

   OR

   Use the ▼ button to go to the bottom of the screen. Select **Favourites**, **Featured**, **Movies**, **TV Shows**, or **Purchased**, and then press the **OK** button. On the page that appears, use the ▲▼◄► buttons to select a show or movie, and then press the **OK** button.

   On the Movies and TV Show screen, you can also select **What’s New**, **Most Popular**, or **Genres** to see more available shows or Films. On the Genre screen, use the ▲▼◄► buttons to select a Genre, and then press the **OK** button.

   To make a selection on a page displaying Movies and TV Show, use the ▲▼◄► buttons to make a selection, and then press the **OK** button.
3. To watch a selection, select Watch now, and then press the \( \text{v} \) button. A selection screen appears listing various locations from which you can rent the film along with prices.

4. Select a location, and then press the \( \text{v} \) button. Follow the directions on the screen to start the movie.

**NOTES**

- If you haven’t logged into your Samsung account, the Log In screen will appear after Step 3 and you will need to log in.
- If you don’t have a credit card associated with your Samsung account, after you log in, the Register Card screen will appear. Follow the directions on the screen. You must have a credit card registered to your account to rent Films and to purchase for-pay apps.

**Using Apps**

You can download applications from the Internet, and access various for pay or free-of-charge application and view them on your TV. To access some applications, you need to have a Samsung account.

**The Apps Screen at a Glance**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Recommended : Displays recommended contents managed by Samsung.</td>
</tr>
<tr>
<td>2</td>
<td>My Apps : Displays your personal gallery of applications modifiable on the More Apps screen.</td>
</tr>
<tr>
<td>3</td>
<td>More Apps : Select to access the More Apps screen where you can add to, modify, and delete applications and see all downloaded applications.</td>
</tr>
<tr>
<td>4</td>
<td>Featured Applications : Use the ( \text{▲▼◄►} ) buttons to highlight the displayed Feature Application, and then press the ( \text{v} ) button. Information about the featured application appears.</td>
</tr>
</tbody>
</table>

**Downloading Applications**

You can download for pay or free-of-charge applications through Samsung Apps.

1. On the Apps screen, select Samsung Apps, and then press the \( \text{v} \) button. The Samsung Apps screen appears.

2. Across the top of the screen, under What’s New, you’ll see a series of new apps. Use the \( ◄► \) buttons to scroll the list right or left, and then select an app. Press the \( \text{v} \) button to see more information about the app. If the app is free, select Download, and then press the \( \text{v} \) button to download the app. If it is a for pay app, select Buy, press the \( \text{v} \) button, and then follow the instructions on the screen.

**NOTES**

- To buy an app, you must be logged into your Samsung account and have a credit card registered to the account. Press the RED (A) button on your remote to log in.
- If you haven’t registered a card, after you log in, press the RED (A) button again, and then select Change Account Information in the pop-up that appears. On the Change Account information page, select Register Card, press the \( \text{v} \) button, and then follow the directions on the screen.
- You can also access and download apps from the categories listed on the left of the screen. For instructions, see Step 4.
3. After the app has downloaded, select **Run**, and then press the \( \text{ } \) button to run the app now. To run the app later, press the **RETURN** button. In either case, the icon for the app will appear on the Apps screen.

4. To see additional apps, use the \( \uparrow \downarrow \leftarrow \rightarrow \) buttons to move to the category list on the left side of the screen.

5. Use the \( \uparrow \downarrow \) buttons to select a category. Each time you move the highlight to another category, a different set of applications appears on the right.

6. Use the \( \rightarrow \) button to move to the applications and the \( \uparrow \downarrow \leftarrow \rightarrow \) buttons to move from app to app.

7. To see more information about an app, select it, and then press the \( \text{ } \) button.

8. To download the app, follow the directions in Steps 2 and 3.

Starting an Application

1. Select **Apps** on the Home screen, and then press the \( \text{ } \) button.

2. On the Apps screen, use the \( \uparrow \downarrow \leftarrow \rightarrow \) buttons to select an app, and then press the \( \text{ } \) button. The app starts.

Using the More Apps Screen

The More Apps Screen lists all the apps you have downloaded and lets you:

- Sort the apps on the More Apps screen by **Date downloaded**, **Recently opened**, and **Title**.
- Apply a number of Options Menu functions to the apps listed in the My Apps section of the Apps screen including updating apps, moving apps into a folder, deleting the apps from My Apps, and locking the apps.
- Start apps.

Sorting the Apps

To sort the apps on the More Apps screen, follow these steps:

1. On the Home screen, select **Apps**, and then press the \( \text{ } \) button.

2. On the Apps screen, use the \( \downarrow \) button to move to the More Apps hotspot at the bottom of the page, and then press the \( \text{ } \) button.

3. On the More Apps screen, use the \( \uparrow \rightarrow \) buttons to move to **View** at the top of the screen, and then press the \( \text{ } \) button.

4. In the drop down that appears, select **Date Downloaded**, **Recently Opened**, or **Title**, and then press the \( \text{ } \) button. The apps on the More Apps screen are sorted by the criteria you have chosen.

Using the Options Menu Functions

Lock/Unlock

Using the Lock/Unlock function and the Security PIN, you can lock applications so they cannot be started on either the Apps screen or the More Apps screen. The default PIN is 0000.

1. On the More Apps screen, use the \( \uparrow \rightarrow \) buttons to go to **Options** at the top of the screen, and then press the \( \text{ } \) button.
Network Services

2. Select Lock/Unlock, and then press the \[button.
3. When the Lock service appears, enter the PIN using the number buttons on your remote control.
4. To lock an application, select the application, and then press the \[ button. A lock appears on the app. Repeat to lock other, individual apps.
5. To unlock a locked app, select the application, and then press the \[ button.
6. To lock all the apps at once, use the \[ buttons to select the Lock All button, and then press the \[ button.
7. To unlock all the locked apps at once, use the \[ buttons to select the Unlock All button and then press the \[ button.
8. Press the RETURN button twice to return to the Apps screen. Locked apps will display a lock on the upper right side.

Edit My Apps

Edit My Apps lets you add apps to and delete apps from My Apps. It also lets you change the position of an app in My Apps.

Add an App to My Apps

1. On the More Apps screen, use the \[ buttons to go to Options at the top of the screen, and then press the \[ button.
2. Select Edit My Apps, and then press the \[ button. The Edit My Apps screen appears.
3. Select a full colour app from the top row of apps, and then press the \[ button. The full colour app icon appears in the My Apps area below and the app icon in the top row is grayed out.

| NOTES |
- Grayed out apps are already in My Apps.

Delete an App from My Apps

1. On the More Apps screen, use the \[ buttons to go to Options at the top of the screen, and then press the \[ button.
2. Select Edit My Apps, and then press the \[ button.
3. Select the app you want to delete from My Apps, press the \[ button, and then press the \[ button in the direction of the X. The Remove from My Apps pop-up appears.
4. Select Yes, and then press the \[ button.
5. When you return to the Apps screen, the app will have been removed from the My Apps area.

Move an App in My Apps

1. On the More Apps screen, use the \[ buttons to go to Options at the top of the screen, and then press the \[ button.
2. Select Edit My Apps, and then press the \[ button. The Edit My Apps screen appears.
3. Select the app you want to move in My Apps, press the \[ button, and then press the \[ button to move the app icon in the direction of one of the arrows (<, >, ^, etc.) that appears around the app icon. The app icon moves in the direction you have chosen.
4. After you have placed the app icon where you want, press the \[ button.
5. When you return to the Apps screen, the app will be positioned in the location you had selected.
Create Folder

Create Folder lets you create a folder on the More Apps screen into which you can put apps.

1. On the More Apps screen, use the ▲► buttons to go to Options at the top of the screen, and then press the ▼ button.
2. Select Create Folder, and then press the ▼ button. The Set Folder Name pop-up appears.
3. Press the ▼ button. The keyboard appears.
4. Select the Clear button on the right side, and then press the ▼ button to remove Folder 1 from the entry field. Then, using the keyboard, enter the name you want to apply to the folder.
5. When finished, select the Done button on the right side, and then press the ▼ button. The pop-up reappears.
6. Select OK, and then press the ▼ button. The new folder appears in the list of apps on the left side of the screen.

Move to Folder

Move to Folder lets you move apps to the folder of your choice.

1. On the More Apps screen, use the ▲► buttons to go to Options at the top of the screen, and then press the ▼ button.
2. Select Move to Folder, and then press the ▼ button. The Move to Folder screen appears.
3. Use the ▲▼◄► buttons to move to an app, and then press the ▼ button to select the app. A check appears in the upper left corner of the app.
4. To deselect an app, press the ▼ button. The check disappears.
5. Repeat Step 3 to select additional apps.

I NOTES I

To select all the downloaded apps, select Select All at the top right of the screen, and then press the ▼ button. To deselect all the apps, select Deselect All at the top right of the screen, and then press the ▼ button.

6. When done, select Select folder at the top of the screen, and then press the ▼ button. The Select folder pop-up appears.
7. In the Select folder pop-up, use the ▲▼ buttons to select the folder you want to move the apps you selected to and then press the ▼ button.
8. The Apps Moved pop up appears. Press the ▼ button.
9. To open a folder, use the ▲▼◄► buttons to highlight the folder, and then press the ▼ button.

Rename Folder

Rename Folder lets you rename an existing folder.

1. On the More Apps screen, use the ▲► buttons to go to Options at the top of the screen, and then press the ▼ button.
2. Select Rename Folder, and then press the ▼ button. The Rename Folder screen appears, and a folder is highlighted.
3. Use the ▲▼◄► buttons to highlight a folder of your choice, and then press the ▼ button. The Rename pop-up appears.
4. Press the ▼ button. The keyboard appears.
5. Enter the new name for the folder. When finished, select Done on the right side, and then press the ▼ button. The Rename pop-up reappears displaying the new name.
6. Select OK, and then press the ▼ button. The folder is renamed.
7. Select Close on the right side of the screen, and then press the ▼ button.
Delete

Delete lets you delete apps and folders from the My Apps screen. If there are apps in a folder, both the folder and the apps are deleted together. Delete removes apps permanently. If you decide you want to use an app you deleted, you will need to download it again.

1. On the More Apps screen, use the ▲► buttons to go to Options at the top of the screen, and then press the ▼ button.
2. Select Delete, and then press the ▼ button. The Delete screen appears.
3. Use the ▲▼◄► buttons to move to an app, or folder and then press the ▼ button to select. A check appears in the upper left corner of the app or folder you selected.
4. To deselect an app, press the ▼ button. The check disappears.
5. Repeat Step 3 to select additional apps or folders.

| NOTES |
- To select all the downloaded apps, select Select All at the top right of the screen, and then press the ▼ button. To deselect all the apps, select Deselect All at the top right of the screen, and then press the ▼ button.
6. After you have made all your selections, select Delete at the top of the screen, and then press the ▼ button. The Delete pop-up appears.
7. Select Yes, and then press the ▼ button. All the apps you selected are deleted.

| NOTES |
- You cannot immediately delete a locked app or folder. If you select a locked app or folder to delete, when you perform Step 7, the Lock Service pop-up appears. Enter the Security PIN into the pop-up, and then press the ▼ button. The lock will be released and the app or folder will be deleted.

Update Apps

Update Apps automatically searches the Internet for updated versions of the apps you have downloaded and updates them if it finds newer versions.

1. On the More Apps screen, use the ▲► buttons to go to Options at the top of the screen, and then press the ▼ button.
2. Select Update Apps, and then press the ▼ button.
3. The unit searches the Internet for newer versions of your apps. If there are new apps, the Update Apps pop-up appears.
4. To download the update for a particular app, highlight the app, and then press the ▼ button. A check appears to the left of the app.
5. To deselect the app, highlight it, and then press the ▼ button.

| NOTES |
- To select all the updates, select Select All on the right of the pop-up, and then press the ▼ button. To deselect all the updates, select Deselect All, and then press the ▼ button.
6. After you have selected the updates you want to download, select Update on the right side of the pop-up, and then press the ▼ button.
7. The unit downloads the updates you have chosen. A download bar appears in each app icon as the update for that app is downloaded. The download is complete when the download bars disappear.
Screen Mirroring

The Screen Mirroring function lets you view the screen of your smart phone or android tablet on the TV you have connected to the Blu-ray player.

1. With the Blu-ray’s Home screen displayed, press the BLUE (D) button on the remote. The Screen Mirroring pop-up appears.
2. Launch AllShare Cast on your device.
3. On your device, find the name of the Blu-ray player in the list of available devices and then select it.
4. The TV will display a PIN. Enter the PIN into your device.
5. The TV displays a connecting message (for example, Connecting to Android_92gb...) and then displays the connected message.
6. In a few moments, the screen of your device appears on the TV screen.
7. To stop Screen Mirroring, press the EXIT or RETURN button on the remote control, or disable Screen Mirroring function of your smart phone.

NOTES

You can connect to a device that supports AllShare Cast. Note that connecting to such a device may not be fully supported depending on the manufacturer. For further information on mobile connection support, refer to the manufacturer’s web site.

When you are using the Screen Mirroring function, video stuttering or audio dropouts may occur, depending on your environment.

Bluetooth transmissions can interfere with the Screen Mirroring signal. Before using the Screen Mirroring function, we strongly recommend that you turn off the Bluetooth function on your smart phone or smart device (tablet, etc.).

Screen Mirroring is only available with mobile devices that support AllShare Cast or Wireless Mirroring. For more information, visit the mobile device manufacturer’s website.

Using the Web Browser

You can access the Internet using the Web Browser application.

Select Web Browser on the Home screen, and then press the button.

NOTES

When you run the Web Browser with the player connected by HDMI to a BD Wise compatible TV - and BD Wise is on - the browser is maximized to fill the screen and the TV’s resolution is set to the optimal resolution automatically.

The Web Browser is not compatible with Java applications.

If you attempt to download a file, and the file cannot be saved, an error message will appear.

E-commerce (purchasing products online) is not supported.

ActiveX is not supported.

Access may be blocked to some websites or to web browsers operated by certain businesses.

Link Browsing and Pointer Browsing

The Web Browser provides two types of browsing, Pointer Browsing and Link Browsing. When you launch the browser for the first time, Pointer Browsing is active. If you are using a mouse to navigate in the Web Browser, we recommend leaving Pointer Browsing active. If you are using your remote to navigate in the Web Browser, we recommend that you replace Pointer Browsing with Link Browsing. Link Browsing moves a highlight from one link to the next in the Web Browser and is much faster than Pointer Browsing if you are using your remote.

To activate Link Browsing, follow these steps:

1. Use the ▲▼◄► buttons on your remote to move the pointer to the Link Browser icon on the top right of the screen. The Link Browser icon is the third icon from the right. The pointer will be in the correct position if the icon turns blue and the words “Link Browsing” appear on the screen.
2. Press the button. Link Browsing is activated and will remain active whenever you bring up the Web Browser.
The Control Panel at a Glance

The Control Panel, which runs across the top of the screen, has a series of icons which start a number of useful functions. The icons are described below, starting with the icon on the far left of the screen.

- : Moves to the previous page.
- : Moves to the next web page.
- : Displays the Bookmarks and History screen. You can bookmark the current page, select an existing bookmark, and edit and delete bookmarks. You can also view your browsing history and select a page to revisit.
- : Moves to the Home screen of the Web Browser.
- : Lets you enter a page address manually using the keyboard pop-up.
- : Reloads the current page so that it is refreshed on the screen.
- : Adds the current page to your bookmarks.
- : Lets you search for information by entering words or characters using the keyboard pop-up. See Using the Keyboard Pop-up on page 56.
- : Lets you enlarge or shrink the screen by various percentages.
- : Lets you switch between Pointer Browsing and Link Browsing.
- : Lets you configure the Browser’s settings. See Using the Settings Menu on page 57.
- : Closes the Web Browser.

Using the Keyboard Pop-up

When you click the button, the or access a data or text entry field, and then press the button, the keyboard pop-up appears.

To use the keyboard pop-up with your remote, follow these steps:

1. Use the buttons on your remote to move the highlight to a letter or number of your choice.
2. Press the button to enter the letter or number into the entry field.
3. To access capital letters, move the highlight to the key on the top left, and then press the button. Press the button again with the key highlighted to access small letters again.
4. To access symbols and additional punctuation marks, highlight the button on the left, and then press the button.
5. To delete a character you entered, move the highlight to the button, and then press the button.
6. To delete all the characters you entered, move the highlight to the button, and then press the button.
7. When finished entering, move the highlight to the button, and then press the button.
If you have a wireless keyboard connected to your player, you can use the wireless keyboard to enter letters, numbers, symbols, and punctuation. Note that the wireless keyboard will work only when the keyboard popup appears and can only be used to enter letters, numbers, symbols, and punctuation.

**Options on the Keyboard Pop-Up**

To access the keyboard pop-up options, highlight the button on the bottom left of the keyboard, and then press the button.

<table>
<thead>
<tr>
<th>Language</th>
<th>Select the language for the keyboard. You can select English, French, Russian, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Text</td>
<td>The keyboard will suggest recommended words as you enter text. You can turn this function On or Off.</td>
</tr>
<tr>
<td>Predict Next Letter</td>
<td>The keyboard will predict the next letter as you enter letters. The predictions appear in a ring around the letter you have just entered. You can select a predicted letter or move to another letter. You can turn this function On or Off.</td>
</tr>
</tbody>
</table>

**Using the Setting Menu**

The Setting menu contains functions that control how the Browser operates and Browser security functions. To open the Setting menu, highlight the icon in the Control Panel, and then press the button. To select an option in the setting menu, highlight the option, and then press the button.

<table>
<thead>
<tr>
<th>Enable/Disable Grabbing</th>
<th>Turns the Grabber function on and off. When the Grabber function is on, you can move a web page up and down without dragging the scroll bar. The Grabber function is only available in Pointer Browsing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved Sites</td>
<td>Lets you restrict your children’s access to inappropriate web pages by allowing access only to the web sites you have registered. Every time you access this function, the PIN screen appears. The first time you access this function, enter the default PIN, 0000 using the number buttons on your remote. You can change the PIN using the Reset password for the Approved Sites function. See below. Approved Sites Feature : Turns the Approved Sites function on or off. Reset password for Approved Sites : Change the Approved Sites password. Add current site : Lets you add the currently displayed web site to the Approved Sites list. Manage Approved Sites : Lets you key in URLs to add to the Approved Sites List and delete sites from the Approved Sites list. If you turn this function on and have not added any sites to the Approved Sites list, you will not be able to access any Internet sites.</td>
</tr>
</tbody>
</table>
# Network Services

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private Browsing On/Off</td>
<td>Enable or disable the Privacy mode. When the Privacy mode is enabled, the browser does not retain the URLs of sites you visit. If you want to enable Privacy mode, select <strong>OK</strong>. If the Privacy mode is running, the “Stop” icon appears in front of the URL at the top of the screen. To disable Privacy mode, select it again when Privacy mode is enabled.</td>
</tr>
<tr>
<td>Web Browser Setting</td>
<td>Set as homepage: You can set the Browser’s home page. Pop-up Block: Turns the Popup Block on and off. Ad Block: You can determine whether to block advertisements and select the URLs for which advertisements are blocked. General: You can delete personal information such as website history and browsing data (cookies, etc.), and reset all web browser settings to their factory defaults. Encoding: You can set the Encoding setting for web pages to Automatic or select the encoding format manually from a list. Pointer: You can set the speed of the cursor when the cursor is set to Pointer and turn Smart Cursor On and Off. Browser Information: Displays the version number and copyright information for the Web Browser.</td>
</tr>
<tr>
<td>Help</td>
<td>Provides basic information about the operation of the Web Browser.</td>
</tr>
</tbody>
</table>

### Linking Your Internet Service Accounts to the Player

The Link Service Accounts function lets you link your player to your accounts with Internet services such as Pandora so that the player can log you in to the service automatically when you start the app for that service.

To create a service account link, follow these steps:

1. On the Home screen, press the RED (A) button on your remote to log in to your Samsung Account.
2. After you have logged in, press the RED (A) button on your remote again.
3. Select **Link Service Accounts** in the My Account pop-up, and then press the OK button.
4. On the Link Service Accounts screen, select the service you want to link to the player, and then press the button.
5. Select **Register**, and then press the button.
6. In the ID and Password screen, enter the ID you use to log in to the service you selected using the pop-up keyboard. When finished, select **Done**, and then press the button.
7. Repeat the same process for the password. When finished select **Done**, and then press the button.
8. Select **OK**, and then press the button.

### NOTES

- Depending on the web site, some of the Web Browser Setting functions may not be activated. Functions that are not activated are greyed out and cannot be used.
Once the player is connected to your network, you can enjoy various movie-related service contents available on BD-LIVE compliant discs.

1. Attach a USB flash memory drive to the USB jack on the front of the player, and then check its remaining memory. The memory device must have at least 1GB of free space to accommodate the BD-LIVE services.

2. Select Settings on the Home screen, and then press the "v" button.

3. Select Network, and then press the "v" button.

4. Select BD-Live Settings, and then press the "v" button.

5. Select BD Data Management, and then press the "v" button.

6. Select Select Device, and then press the "v" button.

7. Select USB device, and then press the "v" button.

8. Insert a Blu-ray Disc that supports BD-LIVE.

9. Select an item from the list of BD-LIVE service contents provided by the disc manufacturer.

| NOTES |
- The way you use BD-LIVE and the provided contents may differ, depending on the disc manufacturer.
NOT ALL discs are compatible

• Subject to the restrictions described below and those noted throughout this Manual, including the Disc Type and Characteristics section of this user manual, disc types that can be played are: pre-recorded commercial BD-ROM, DVD-VIDEO, and Audio CD (CD-DA); BD-RE/-R, DVD-RW/-R; and CD-RW/-R.

• Discs other than the above cannot and/or are not intended to be played by this player. And some of the above discs may not play due to one or more reasons provided below.

• Samsung cannot assure that this player will play every disc bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos, and this player may not respond to all operating commands or operate all features of every disc. These and other disc compatibility and player operation issues with new and existing format discs are possible because:
  - Blu-ray is a new and evolving format and this player may not operate all features of Blu-ray Discs because some features may be optional, additional features may have been added to the Blu-ray Disc format after the production of this player, and certain available features may be subject to delayed availability;
  - not all new and existing disc format versions are supported by this player;
  - new and existing disc formats may be revised, changed, updated, improved and/or supplemented;
  - some discs are produced in a manner that allows specific or limited operation and feature during playback;
  - some features may be optional, additional features may have been added after the production of this player or certain available features may be subject to delayed availability;
  - some discs bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos may still be non-standardized discs;
  - some discs may not be played depending on their physical state or recording conditions;
  - problems and errors can occur during the creation of Blu-ray Disc, DVD software and/or the manufacture of discs;
  - this player operates differently than a standard DVD player or other AV equipment; and/or
  - for reasons noted throughout this user manual and for other reason(s) discovered and posted by SAMSUNG customer care centre.

• If you encounter disc compatibility or player operation problems, please contact SAMSUNG customer care centre.

You may also contact SAMSUNG customer care centre for possible updates on this player.

• For additional information on playback restrictions and disc compatibility, refer to the Precautions, Before Reading the user manual, Disc Types and Characteristics, and Before Playing sections of this user manual.

• For Blu-ray Disc Player progressive scan output: CONSUMERS SHOULD NOTE THAT NOT ALL HIGH DEFINITION TELEVISION SETS ARE FULLY COMPATIBLE WITH THIS PRODUCT AND MAY CAUSE ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN CASE OF PROGRESSIVE SCAN PICTURE PROBLEMS, IT IS RECOMMENDED THAT THE USER SWITCH THE CONNECTION TO THE 'STANDARD DEFINITION' OUTPUT. IF THERE ARE QUESTIONS REGARDING OUR TV SET COMPATIBILITY WITH THIS PRODUCT, PLEASE CONTACT OUR CUSTOMER SERVICE CENTRE.
Copy Protection

- Because AACS (Advanced Access Content System) is approved as content protection system for Blu-ray Disc format, similar to use of CSS (Content Scramble System) for DVD format, certain restrictions are imposed on playback, Analog signal output, etc., of AACS protected contents. The operation of this product and restrictions on this product may vary depending on your time of purchase as those restrictions may be adopted and/or changed by AACS after the production of this product. Furthermore, BD-ROM Mark and BD+ are additionally used as content protection system for Blu-ray Disc format, which imposes certain restrictions including playback restrictions for BD-ROM Mark and/or BD+ protected contents. To obtain additional information on AACS, BD-ROM Mark, BD+, or this product, please contact SAMSUNG customer care centre.

- Many Blu-ray Disc/DVDs are encoded with copy protection. Because of this, you should only connect your Player directly to your TV, not to a VCR. Connecting to a VCR results in a distorted picture from copy-protected Blu-ray Disc/DVDs.

- Under the U.S. Copyright laws and Copyright laws of other countries, unauthorised recording, use, display, distribution, or revision of television programs, videotapes, Blu-ray Discs, DVDs, and other materials may subject you to civil and/or criminal liability.

- Cinavia Notice: This product uses Cinavia technology to limit the use of unauthorised copies of some commercially-produced film and videos and their soundtracks. When a prohibited use of an unauthorised copy is detected, a message will be displayed and playback or copying will be interrupted.

More information about Cinavia technology is provided at the Cinavia Online Consumer Information Centre at http://www.cinavia.com. To request additional information about Cinavia by mail, send a postcard with your mailing address to: Cinavia Consumer Information Centre, P.O. Box 86851, San Diego, CA, 92138, USA.

This product incorporates proprietary technology under licence from Verance Corporation and is protected by U.S. Patent 7,369,677 and other U.S. and worldwide patents issued and pending as well as copyright and trade secret protection for certain aspects of such technology. Cinavia is a trademark of Verance Corporation. Copyright 2004-2010 Verance Corporation. All rights reserved by Verance. Reverse engineering or disassembly is prohibited.

Network Service Disclaimer

All content and services accessible through this device belong to third parties and are protected by copyright, patent, trademark and/or other intellectual property laws. Such content and services are provided solely for your personal noncommercial use. You may not use any content or services in a manner that has not been authorised by the content owner or service provider. Without limiting the foregoing, unless expressly authorised by the applicable content owner or service provider, you may not modify, copy, republish, upload, post, transmit, translate, sell, create derivative works, exploit, or distribute in any manner or medium any content or services displayed through this device.
THIRD PARTY CONTENT AND SERVICES ARE PROVIDED "AS IS." SAMSUNG DOES NOT WARRANT CONTENT OR SERVICES SO PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY, FOR ANY PURPOSE. SAMSUNG EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SAMSUNG DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH THIS DEVICE AND UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN CONTRACT OR TORT, FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER DAMAGES ARISING OUT OF, OR IN CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE OF ANY CONTENT OR SERVICE BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Third party services may be terminated or interrupted at any time, and Samsung makes no representation or warranty that any content or service will remain available for any period of time. Content and services are transmitted by third parties by means of networks and transmission facilities over which Samsung has no control. Without limiting the generality of this disclaimer, Samsung expressly disclaims any responsibility or liability for any interruption or suspension of any content or service made available through this device.

Samsung is neither responsible nor liable for customer service related to the content and services. Any question or request for service relating to the content or services should be made directly to the respective content and service providers.

Licence

- Manufactured under licence from Dolby Laboratories. Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.

- Manufactured under licence under U.S. Patent Nos: 5,956,674; 5,974,380; 6,226,616; 6,487,535; 7,212,872; 7,333,929; 7,392,195; 7,272,567 & other U.S. and worldwide patents issued & pending. DTS-HD, the Symbol, & DTS-HD and the Symbol together are registered trademarks & DTS-HD Master Audio is a trademark of DTS, Inc. Product includes software. © DTS, Inc. All Rights Reserved.

- DivX
  - ABOUT DIVX VIDEO: DivX® is a digital video format created by DivX, LLC, a subsidiary of Rovi Corporation. This is an official DivX Certified® device that plays DivX video. Visit divx.com for more information and software tools to convert your files into DivX videos.
  - ABOUT DIVX VIDEO-ON-DEMAND: This DivX Certified® device must be registered in order to play purchased DivX Video-on-Demand (VOD) movies. To obtain your registration code, locate the DivX VOD section in your device setup menu. Go to vod.divx.com for more information on how to complete your registration.
  - DivX Certified® to play DivX® video up to HD 1080p, including premium content. DivX®, DivX Certified® and associated logos are trademarks of Rovi Corporation or its subsidiaries and are used under licence. Covered by one or more of the following U.S. patents : 7,295,673; 7,460,668; 7,515,710; 7,519,274.
The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trademarks of HDMI Licensing LLC in the United States and other countries.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Open Source Licence Notice
- In the case of using open source software, Open Source Licences are available on the product menu.

Blu-ray Disc™, Blu-ray™ and the logos are trademarks of the Blu-ray Disc Association.

Recommendation - EU Only
- Hereby, Samsung Electronics, declares that this BD Player is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC. The official Declaration of Conformity may be found at http://www.samsung.com, go to Support > Search Product Support and enter the model name. This equipment may be operated in all EU countries. This equipment may only be used indoors.
### Notes

<table>
<thead>
<tr>
<th>Settings</th>
<th>3D Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>• For some 3D discs, to stop a movie during 3D playback, press the (STOP) button once. The movie stops and the 3D mode option is de-activated. To change a 3D option selection when you are playing a 3D movie, press the (STOP) button once. The Blu-ray menu appears. Press the (STOP) button again, then select 3D Settings in the Blu-ray menu. • Depending on the content and the position of the picture on your TV screen, you may see vertical black bars on the left side, right side, or both sides.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>TV Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Depending on the disc type, some aspect ratios may not be available. • If you select an aspect ratio and option that is different than the aspect ratio of your TV screen, the picture might appear to be distorted. • If you select the 16:9 Original, your TV may display 4:3 Pillarbox (black bars on sides of picture).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>BD Wise (Samsung Players only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD Wise appears in the Resolution menu. • If the player is connected to a device that does not support BD Wise, you can not use the BD Wise function. • For proper operation of BD Wise, set the BD Wise option of both the player and the TV to On.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Digital Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Be sure to select the correct Digital Output or you will hear no sound or just loud noise. • If the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby Digital, DTS), the audio signal outputs as PCM. • Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects. • Some Blu-ray Discs do not have BONUSVIEW audio and Navigation Sound Effects. • This Digital Output setup does not affect the HDMI audio output to your TV. It affects the optical and HDMI audio output when your player is connected to an AV receiver. • If you play MPEG audio soundtracks, the audio signal outputs as PCM regardless of your Digital Output selections (PCM or Bitstream).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>PCM Downsampling</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Even when PCM Downsampling is set to Off, some discs will only output downsampled audio through the optical digital output. • HDMI - If your TV is not compatible with compressed multi-channel formats (Dolby Digital, DTS), the player may output PCM 2ch downmixed audio even though you selected Bitstream (either Reencoded or Unprocessed) in the setup menu. - If your TV is not compatible with PCM sampling rates over 48kHz, the player may output 48kHz.</td>
<td></td>
</tr>
</tbody>
</table>
### Settings

**BD-LIVE Internet Connection**
- What is a valid certificate?
  When the player uses BD-LIVE to send the disc data and a request to the server to certify the disc, the server uses the transmitted data to check if the disc is valid and sends the certificate back to the player.
- The Internet connection may be restricted while you are using BD-LIVE contents.

**BD Data Management**
- In the external memory mode, disc playback may be stopped if you disconnect the USB device in the middle of playback.
- Only those USB devices formatted in the FAT file system (DOS 8.3 volume label) are supported. We recommend you use USB devices that support USB 2.0 protocol with 4 MB/sec or faster read/write speed.
- The Resume Play function may not work after you format the storage device.
- The total memory available to BD Data Management may differ, depending on conditions.

**Anynet+ (HDMI-CEC)**
- Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.
- This function is not available if the HDMI cable does not support CEC.
- If your Samsung TV has an Anynet+ logo, then it supports the Anynet+ function.

### Media Play

**Selecting the Audio Language**
- The ◄► indicator will not appear on the screen if the BONUSVIEW section does not contain any BONUSVIEW audio settings.
- The languages available through the Audio Language function depend on the languages that are encoded on the disc. This function or certain languages may not be available.
- Some Blu-ray Discs may allow you to select either the PCM or Dolby Digital audio soundtrack in English.

**Selecting the Subtitle Language**
- Depending on the Blu-ray Disc / DVD, you may be able to change the subtitle language in the Disc Menu. Press the **DISC MENU** button.
- This function depends on the selection of subtitles that are encoded on the disc and may not be available on all Blu-ray Discs/DVDs.
- Information about the main feature BONUSVIEW mode will also appear if the Blu-ray Disc has a BONUSVIEW section.
- This function changes both the primary and secondary subtitles at the same time.
- The total number of primary and secondary subtitles are displayed respectively.
- If you press the **SUBTITLE** button on the remote control, the subtitle bar appears. Press the **RETURN** button to remove the subtitle bar.
### Resolution according to the contents type

<table>
<thead>
<tr>
<th>Setup</th>
<th>Contents Type</th>
<th>Blu-ray Disc</th>
<th>E-contents/ Digital contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>BD Wise</td>
<td>Resolution of Blu-ray Disc</td>
<td>1080p</td>
</tr>
<tr>
<td></td>
<td>4K Output : Auto</td>
<td>2160p@24F</td>
<td>2160p@24F</td>
</tr>
<tr>
<td></td>
<td>4K Output : Off</td>
<td>1080p@24F</td>
<td>1080p@24F</td>
</tr>
<tr>
<td></td>
<td>Movie Frame : Off</td>
<td>Max. Resolution of TV input</td>
<td>Max. Resolution of TV input</td>
</tr>
<tr>
<td></td>
<td>1080p&amp;1080i only</td>
<td>1080p@24F</td>
<td>1080p@24F</td>
</tr>
<tr>
<td></td>
<td>1080p</td>
<td>1080p</td>
<td>1080p</td>
</tr>
<tr>
<td></td>
<td>1080i</td>
<td>1080i</td>
<td>1080i</td>
</tr>
<tr>
<td></td>
<td>720p</td>
<td>720p</td>
<td>720p</td>
</tr>
</tbody>
</table>

### Setup

<table>
<thead>
<tr>
<th>Contents Type</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BD Wise</td>
</tr>
<tr>
<td>Movie Frame : Auto</td>
<td>576i/480i</td>
</tr>
<tr>
<td>DVD 24Fs Conversion : Auto</td>
<td>2160p@24F</td>
</tr>
<tr>
<td>4K Output : Auto</td>
<td>1080p@24F</td>
</tr>
<tr>
<td>4K Output : Off</td>
<td>Max. Resolution of TV input</td>
</tr>
<tr>
<td>DVD 24Fs Conversion : Off</td>
<td>Max. Resolution of TV input</td>
</tr>
<tr>
<td>Movie Frame : Off</td>
<td>1080p@24F</td>
</tr>
<tr>
<td>1080p&amp;1080i only</td>
<td>1080p@24F</td>
</tr>
<tr>
<td>1080p</td>
<td>1080p@60F</td>
</tr>
<tr>
<td>1080i</td>
<td>1080i</td>
</tr>
<tr>
<td>720p</td>
<td>720p</td>
</tr>
<tr>
<td>576p/480p</td>
<td>576p/480p</td>
</tr>
</tbody>
</table>

### NOTES
- If the TV you connected to the player does not support Movie Frame or the resolution you selected, the message “If no pictures are shown after selecting 'Yes', please wait for 15 seconds to return to the previous resolution. Do you want to change the resolution?” appears. If you select Yes, the TV’s screen will go blank for 15 seconds, and then the resolution will revert to the previous resolution automatically.
- If the screen stays blank after you have changed the resolution, remove all discs, and then press and hold the button on the top of the player for more than 5 seconds. All settings are restored to the factory default. Run the Initial Settings procedure again. Then, go to Settings > Display > Resolution in the Menu, and select the correct resolution for your TV.
- When you run the Initial Settings procedure, re-select the language and aspect ratio (screen size and format) only. Resetting does not affect your network settings, so you should be able to skip Network Setup and Software Update.
- When the factory default settings are restored, all stored user BD data will be deleted.
- The Blu-ray Disc must have the 24 frame feature for the player to use the Movie Frame (24Fs) mode.
### Digital Output Selection

<table>
<thead>
<tr>
<th>Setup</th>
<th>PCM</th>
<th>Bitstream (Unprocessed)</th>
<th>Bitstream (Re-encoded DTS)</th>
<th>Bitstream (Re-encoded Dolby D)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI supported AV receiver</td>
<td>Optical</td>
<td>HDMI supported AV receiver</td>
<td>Optical</td>
<td>HDMI supported AV receiver or Optical</td>
</tr>
<tr>
<td><strong>Connection</strong></td>
<td><strong>Setup</strong></td>
<td><strong>PCM</strong></td>
<td><strong>Bitstream (Unprocessed)</strong></td>
<td><strong>Bitstream (Re-encoded DTS)</strong></td>
</tr>
<tr>
<td>PCM</td>
<td>PCM</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>PCM</td>
</tr>
<tr>
<td>Dolby Digital</td>
<td>PCM</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>Dolby Digital</td>
</tr>
<tr>
<td>Dolby Digital Plus</td>
<td>PCM</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>Dolby Digital Plus</td>
</tr>
<tr>
<td>Dolby TrueHD</td>
<td>PCM</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>Dolby TrueHD</td>
</tr>
<tr>
<td>DTS</td>
<td>PCM</td>
<td>Up to PCM 6.1ch</td>
<td>PCM 2ch</td>
<td>DTS</td>
</tr>
<tr>
<td>DTS-HD High Resolution Audio</td>
<td>PCM</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>DTS-HD High Resolution Audio</td>
</tr>
<tr>
<td>DTS-HD Master Audio</td>
<td>PCM</td>
<td>Up to PCM 7.1ch</td>
<td>PCM 2ch</td>
<td>DTS-HD Master Audio</td>
</tr>
<tr>
<td><strong>Audio Stream on Blu-ray Disc</strong></td>
<td>PCM</td>
<td>PCM 2ch</td>
<td>PCM 2ch</td>
<td>PCM 2ch</td>
</tr>
<tr>
<td>Dolby Digital</td>
<td>PCM</td>
<td>Up to PCM 5.1ch</td>
<td>PCM 2ch</td>
<td>Dolby Digital</td>
</tr>
<tr>
<td>DTS</td>
<td>PCM</td>
<td>Up to PCM 6.1ch</td>
<td>PCM 2ch</td>
<td>DTS</td>
</tr>
<tr>
<td><strong>Definition for Blu-ray Disc</strong></td>
<td>Any</td>
<td>Decodes the main feature audio and BONUSVIEW audio stream together into PCM audio and adds Navigation Sound Effects. Outputs only the main feature audio stream so that your AV receiver can decode the audio bitstream. You will not hear BONUSVIEW audio or Navigation Sound Effects.</td>
<td>Decodes the main feature audio and BONUSVIEW audio stream together into PCM audio and adds Navigation Sound Effects, then re-encodes the PCM audio into DTS bitstream.</td>
<td>Decodes the main feature audio and BONUSVIEW audio stream together into PCM audio and adds Navigation Sound Effects, then re-encodes the PCM audio into Dolby Digital bitstream or PCM.</td>
</tr>
</tbody>
</table>

* If the Source Stream is 2ch or mono, "Re-encoded Dolby D" Settings are not applied. Output will be PCM 2ch.

Blu-ray Discs may include three audio streams:
- **Main Feature Audio**: The audio soundtrack of the main feature.
- **BONUSVIEW audio**: An additional soundtrack such as the director or actor’s commentary.
- **Navigation Sound Effects**: When you choose some menu navigation, Navigation Sound Effects may sound. Navigation Sound Effects are different on each Blu-ray Disc.
# Troubleshooting

Before requesting service, please try the following solutions.

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
</table>
| No operation can be performed with the remote control. | • Check the batteries in the remote control. They may need replacing.  
• Operate the remote control at a distance of no more than 6.1m from the player.  
• Remove the batteries and hold down one or more buttons for several minutes to drain the microprocessor inside the remote control to reset it. Reinstall the batteries and try to operate the remote control again. |
| The disc does not play. | • Ensure that the disc is installed with the label side facing up.  
• Check the region number of the Blu-ray Disc/DVD. |
| The disc Menu does not appear. | • Ensure that the disc has disc menus. |
| The prohibition message appears on the screen. | • This message appears when an invalid button is pressed.  
• The Blu-ray Disc/DVD’s software doesn’t support the feature (e.g., angles).  
• You’ve requested a title or chapter number or search time that is out of range. |
| Play mode differs from the Setup Menu selection. | • Some of the functions selected in the Setup Menu may not work properly if the disc is not encoded with the corresponding function. |
| The screen ratio cannot be changed. | • The Screen Ratio is fixed on your Blu-ray Disc/DVD.  
• This is not a problem with the player. |
| No audio. | • Make sure you have selected the correct Digital Output in the Audio Options Menu. |
| The screen is blank. | • If the HDMI output is set to a resolution your TV cannot support (for example, 1080p), you may not see a picture on your TV.  
• Press the ■ button (on top panel) for more than 5 seconds with no disc inside. All settings will revert to the factory settings.  
• When the factory default settings are restored, all stored user BD data will be deleted. |
| Forgot password. | • Press the ■ button (on top panel) for more than 5 seconds with no disc inside. All settings including the password will revert to the factory settings. Don’t use this unless absolutely necessary.  
• When the factory default settings are restored, all stored user BD data will be deleted. |
<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>The picture is noisy or distorted.</td>
<td>• Make sure that the disc is not dirty or scratched.</td>
</tr>
<tr>
<td></td>
<td>• Clean the disc.</td>
</tr>
<tr>
<td>No HDMI output.</td>
<td>• Check the connection between the TV and the HDMI jack of the player.</td>
</tr>
<tr>
<td></td>
<td>• Check if your TV supports the 576p/480p, 720p, 1080i, 1080p or 2160p HDMI input resolution.</td>
</tr>
<tr>
<td>Abnormal HDMI output screen.</td>
<td>• If random noise appears on the screen, it means that TV does not support HDCP (High-bandwidth Digital Content Protection).</td>
</tr>
<tr>
<td>If you experience other problems.</td>
<td>• Go to the table of contents and find the section of the user manual that contains information about the feature you are having the problem with, and then follow the procedure again.</td>
</tr>
<tr>
<td></td>
<td>• If you still cannot resolve the problem, please contact your nearest Samsung authorised service centre.</td>
</tr>
</tbody>
</table>

**AllShare function**

<table>
<thead>
<tr>
<th>I can see folders shared through AllShare, but I cannot see the files.</th>
<th>AllShare only shows Video, Photo, and Music files. Other types of files are not displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The video plays intermittently.</td>
<td>• Check if the network is stable.</td>
</tr>
<tr>
<td></td>
<td>• Check if the network cable is properly connected and if the network is not overloaded.</td>
</tr>
<tr>
<td></td>
<td>• The wireless connection between the AllShare compatible device and the player is unstable. Check the connection.</td>
</tr>
<tr>
<td>The AllShare connection between the player and the PC is unstable.</td>
<td>• IP addresses within the same subnetwork should be unique. If they are not, IP interference can cause this phenomenon.</td>
</tr>
<tr>
<td></td>
<td>• Check if you have a firewall enabled. If so, disable the firewall function.</td>
</tr>
</tbody>
</table>
Appendix

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
</table>
| BD-LIVE | I cannot connect to the BD-LIVE server.  
• Test whether the network connection is working using the Network Status function. (See page 26)  
• Check whether a USB memory device is connected to the player.  
• The memory device must have at least 1GB of free space to accommodate the BD-LIVE service.  
You can check the available size in BD Data Management. (See page 26)  
• See if the BD-LIVE Internet Connection option is set to Allow(All).  
• If all above fails, contact the contents provider or update to the player to the latest firmware. |
| | When using the BD-LIVE service, an error occurs.  
• The memory device must have at least 1GB of free space to accommodate the BD-LIVE service.  
You can check the available size in BD Data Management. (See page 26) |

I NOTES I

› When the factory default settings are restored, all stored user BD data will be deleted.

Repairs

If you contact us to repair your player, an administration fee may be charged if either:

1. An engineer is called out to your home at your request and there is no defect in the product.
2. You bring the unit to a repair centre and there is no defect in the product.

We will provide you with the amount of the administration fee before we make a home visit or begin any work on your player.

We recommend you read this manually thoroughly, search for a solution on line at www.samsung.com, or contact Samsung Customer Care before seeking to repair your player.
## Specifications

<table>
<thead>
<tr>
<th>General</th>
<th>Weight</th>
<th>1.7 Kg</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dimensions</td>
<td>430 (W) X 201 (D) X 43 (H) mm</td>
</tr>
<tr>
<td></td>
<td>Operating Temperature Range</td>
<td>+5°C to +35°C</td>
</tr>
<tr>
<td></td>
<td>Operating Humidity Range</td>
<td>10 % to 75 %</td>
</tr>
<tr>
<td>USB</td>
<td>Type A</td>
<td>USB 2.0</td>
</tr>
<tr>
<td></td>
<td>DC output</td>
<td>5V 500mA Max.</td>
</tr>
<tr>
<td>HDMI</td>
<td>Video</td>
<td>2D : 2160p, 1080p, 1080i, 720p, 576p/480p</td>
</tr>
<tr>
<td></td>
<td>Audio</td>
<td>3D : 1080p, 720p</td>
</tr>
<tr>
<td></td>
<td>PCM, Bitstream</td>
<td></td>
</tr>
<tr>
<td>Audio Output</td>
<td>7.1 Channel</td>
<td>Front Left/Front Right, Centre, Subwoofer, Surround Left/Surround Right, Surround Back Left/Surround Back Right</td>
</tr>
<tr>
<td></td>
<td>Digital Audio Output</td>
<td>Optical</td>
</tr>
<tr>
<td>Network</td>
<td>Ethernet</td>
<td>100BASE - TX Terminal</td>
</tr>
<tr>
<td></td>
<td>Wireless LAN</td>
<td>Built-in</td>
</tr>
<tr>
<td></td>
<td>Security</td>
<td>WEP (OPEN/SHARED)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WPA-PSK (TKIP/AES)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WPA2-PSK (TKIP/AES)</td>
</tr>
<tr>
<td></td>
<td>WPS(PBC)</td>
<td>Supported</td>
</tr>
</tbody>
</table>

- Network speeds equal to or below 10Mbps are not supported.
- Design and specifications are subject to change without prior notice.
- For the power supply and power consumption, refer to the label attached to the player.
- Weight and dimensions are approximate.
This Samsung product is warranted for the period of twelve (12) months from the original date of purchase, against defective materials and workmanship. In the event that warranty service is required, you should return the product to the retailer from whom it was purchased. However, Samsung Authorised Dealers and Authorised Service Centres in other EC Countries will comply with the warranty on the terms issued to purchasers in the country concerned. In case of difficulty, details of our Authorised Service Centres are available from:

Customer Support Centre, PO Box 479, Gatehead, Ne9 9BJ
United Kingdom
Tel: 0330 SAMSUNG (7267864)
Fax: 033 07260001
www.samsung.com/uk
Eire
Tel: 0818 717100
Fax: +44(0)117 915 6736
www.samsung.com/ie

**WARRANTY CONDITIONS**

1. The warranty is only valid if, when warranty service is required, the warranty card is fully and properly completed and is presented with the original invoice or sales slip or confirmation, and the serial number on the product has not been defaced.

2. Samsung’s obligations are limited to the repair or, at its discretion, replacement of the product or the defective part.

3. Warranty repairs must be carried out by Authorised Samsung Dealers or Authorised Service Centres. No re-imbursement will be made for repairs carried out by non Samsung Dealers and, any such repair work and damage to the products caused by such repair work will not be covered by this warranty.

4. This product is not considered to be defective in materials nor workmanship by reason that it requires adaptation in order to conform to national or local technical or safety standards in force in any Country other than the one for which the product was originally designed and manufactured. This warranty will not cover, and no re-imbursement will be made for such adaptation nor any damage which may result.

5. This warranty covers none of the following:
   a) Periodic check ups, maintenance and repair or replacement of parts due to normal wear and tear.
   b) Cost relating to transport, removal or installation of the product.
   c) Misuse, including the failure to use this product for its normal purposes or incorrect installation.

6. This warranty is valid for any person who legally acquired possession of the product during the warranty period.

7. The consumers statutory rights in any applicable national legislation whether against the retailer arising from the purchase contract or otherwise are not affected by this warranty. Unless there is national legislation to the contrary, the rights under this warranty are the consumers sole rights and Samsung, its subsidiaries and distributors shall not be liable for indirect or consequential loss or any damage to records, compact discs, videos or audio taper or any other related equipment or material.

SAMSUNG ELECTRONICS (U.K.) LTD.
Correct disposal of batteries in this product
(Applicable in the European Union and other European countries with separate battery return systems.)

This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed of with other household waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium or lead above the reference levels in EC Directive 2006/66.

If batteries are not properly disposed of, these substances can cause harm to human health or the environment.

To protect natural resources and to promote material reuse, please separate batteries from other types of waste and recycle them through your local, free battery return system.

Correct Disposal Of This Product (Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate collection systems)

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB cable) should not be disposed of with other household waste at the end of their working life.

To prevent possible harm to the environment or human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to promote the sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and how they can take these items for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the purchase contract.

This product and its electronic accessories should not be mixed with other commercial wastes for disposal.